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1 About Outpost 
1.1 What is Outpost? 

Outpost is a PC-based messaging client that lets you to exchange your packet 
messages with almost any Amateur Radio Bulletin Board System (BBS). 

Using your existing Terminal Node Controller (TNC) or AGWPE-enabled sound-
card, radio, and a Windows-based PC, all you need to know is your call sign, 
information about your TNC, and information about the BBS.  Once the program is 
configured, Outpost then manages all message-handling between your PC and the 
BBS.  Outpost also lets you send, receive, read, delete, create, reply to, or forward 
messages back to the BBS. 

Unlike commercial mail systems, BBS-based mail is transmitted unencrypted over 
the amateur radio bands.  There is nothing private about it. 

1.2 Why Outpost? 
Outpost was created to support the packet communication needs of an ARES, 
RACES, or other emergency communications response team during a disaster or 
other activation where Amateur Radio is deployed. 

During an emergency, you may be required to pass lists of information or detailed 
instructions within an Operational Area to support Logistics, Operations, or 
Planning/Intel activities as required by a municipality�s Emergency Operations 
Center (EOC).  Packet is ideal for this task.  Outpost makes the job even easier by 
automating the manual interaction between you and the BBS. 

Because Outpost leverages the existing Packet Infrastructure, it can be deployed 
relatively easily and quickly.  Outpost can either operate as a single stand-alone 
messaging client, or collaboratively with other Outpost stations using built-in 
features that to enhance overall message handling effectiveness. 

If Outpost had a tag line, it would be: �Focus on the message, not the medium.�  
An emergency activation is not the time to think about packet training.  By using an 
application with a look and feel similar to contemporary email clients, Outpost 
helps emergency communicators get a packet message written and transmitted 
quickly without all operators needing to be packet experts. 

A successful Outpost deployment does require a few things:  

▪ At least one individual who has a fundamental understanding of packet, and can 
configure and verify that Outpost is operational prior to a response. 

▪ A definition of your emergency response team�s operating policies for packet 
messaging.  Operating policies are the guidelines that would be observed 
during an activation.   
 
Examples of a policy would be things like (i) no keyboard-to-keyboard 
communications will be used, (ii) polling the Operational BBS will occur no 
more frequently than every 15 minutes, (iii) tactical call signs will be used, etc.  
Most packet messaging policies can be implemented through Outpost. 
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1.3 A typical TNC Session today 
Before Outpost, if you wanted to send and receive a packet message, you needed a 
terminal emulator program and be familiar with commands for controlling your 
TNC and a remote BBS.  For instance, you probably did something like this: 

Figure 1: Sample TNC session using Hyperterm 

1. Turn on your Computer and run your terminal emulator.  You may be using 
PACTERM or some other TNC program.  I�ve used the general-purpose 
MS-Windows HYPERTERM program because of its ability to cut-and-
paste text to and from it. 

2. Turn on your TNC.  Verify you see the TNC welcome message.   

3. Turn on your radio and select the frequency on which the BBS operates. 

4. Check the configuration of the TNC.  This could include sending the MY 
command to review or change the TNC�s call sign, setting the date and 
time, or changing any display settings with the ECHO or AUTOLF 
commands. 

5. Connect to the BBS.  After issuing the Connect <call sign> command, 
you verify the BBS responds with its welcome message. 

6. Once connected, you check for messages addressed to you with the LM (list 
mine) command.  If you operate NTS packet, you may check for any NTS 
messages with the LT (list traffic) command.  Then, you may read them 
with the Read <####> command (where #### is the message number) and 
delete them off the BBS with the Kill <####> command. 

7. You may also check out current bulletins with the LB (list bulletins) 
command, and then read them one by one. 

8. If you wanted to send a private message to a friend, you would enter the  
SP <call sign> command (send private).  When prompted, you enter the 
subject, and then the message.   

NOTE:  As a reminder, every time you press Enter on your keyboard, the line of text 
you just typed is sent to the TNC and transmitted to the BBS.  The only way to 
correct an error in your message is to finish your message, delete it from the 
BBS, and start over. 

9. When done, you exit the BBS with the B or Bye command. 
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10. Because you don�t know when your friend would get the message, you 
would repeat steps #5, #6, and #9 to see if you have a reply. 

During normal operation, the above steps can get tedious, in particular if you are 
expecting a reply. 

During an emergency, you may have an established routine to do something similar, 
with more purpose and intent to the steps outlined above. 

1.4 A Typical Outpost Session 
Outpost takes care of a lot of the above steps.  Once configured, Outpost takes on 
the job of sending and processing all TNC and BBS commands during a �Packet 
Session.�  Because you have previously told Outpost what the TNC and BBS 
prompts and commands are, Outpost automatically sends, waits, receives, and 
processes all exchanges with the BBS. 

 

Figure 2: Outpost’s Main window 

Here is what you would do with Outpost: 

1. Turn on your Computer and run Outpost.   

2. Turn on your TNC.   

3. Turn on your radio and select the frequency. 

4. Confirm that Outpost has the correct TNC and BBS selected. 

5. From Outpost, press the Send/Receive button. 

6. Outpost will automatically: 

▪ Send the appropriate TNC commands to get it ready for a TNC Session. 

▪ Connect to the BBS by sending the Connect <bbs> command. 

▪ Check to see if you have any private messages in the Outpost Out Tray 
to be sent to this BBS.  If so, it will send them with the SP Command.  
It then does the same for any NTS or Bulletins you may want to send. 

▪ Check for messages addressed to you with the LM command.  Outpost 
will read these messages with the R <####> command, then delete 
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them off the BBS with the K <####> command.  Outpost will also 
check for and retrieve NTS and bulletins if selected. 

▪ Finally log off the BBS with the Bye command. 

▪ If configured, Outpost will repeat this cycle on a regular interval as 
defined by you. 

In short, Outpost automates the packet session by sending TNC and BBS 
commands, looking for prompts, and responding with the next appropriate 
command.  

Whatever you manually type at the keyboard into your terminal emulator program, 
Outpost does this for you automatically. 

1.5 Outpost Features 

 Message Management 
1. Multiple mail folders.  Outpost allows the user to manage messages in a 

series of folders, including an In Tray, Out Tray, Sent Folder, Draft, 
Archive, and Deleted Items Folders.  These folders are permanently 
defined. 

2. Message Types.  Outpost supports three primary message types:  Private, 
NTS, and Bulletins.  Sent and received messages are displayed with their 
appropriate types indicated. 

3. Message Creation.  Outpost allows messages to be created from scratch, 
importing text from an ASCII file, cut and pasted in from other 
applications, or by Replying to or Forwarding a previously received 
message. 

4. Text Message Formatting.  Messages can be entered in a free-form text 
area.  Simple formatting can be performed, errors corrected, and text can be 
added and deleted prior to sending the message. 

5. NTS Message Maker.  Outpost also helps format NTS messages.  The NTS 
Message Maker is a forms-based menu that prompts for all required fields 
needed to create a correctly formatted NTS packet message.  ARL 
Messages can also be added and automatically formatted. 

6. Report Interpreter.  Outpost supports an online report interpreter that helps 
get a pre-defined report filled in and formatted quickly. 

7. Message archiving.  After an emergency, the entire message database can 
be archived to either an Outpost-readable format for importing later on, or a 
user-readable format. 

February 2006 4



Outpost Packet Message Manager v2.0.4 
Users Guide 

 Packet Session Management 
8. Serial Comm Port Management.  Outpost supports direct serial 

communications with a TNC by setting up the serial port and handling any 
contention for the port that may exist. 

9. AGWPE Support.  Outpost supports the AGWPE application located either 
locally on the same PC as Outpost, or somewhere else on the network. 

10. Telnet Support.  Outpost supports Telnet access to a network-accessible 
BBS.   

11. Interface Management.  Outpost sends all initialization commands to the 
TNC, AGWPE, and Telnet interface to prepare it for a packet session. 

12. BBS Management.  Outpost sends the right BBS commands at the right 
time. 

 

Figure 3: Outpost’s New Message window 

 Configurations and Setups 
13. Interface configuration setup 

14. TNC configuration setup.  Outpost manages a list of Interfaces, TNCs and 
their commands.  TNCs can be added or deleted. 

15. BBS configuration setup.  Outpost will manage a list of BBS�s and their 
commands.  BBSs can be added or deleted. 

16. Message retrieval.  Outpost allows the user to choose which types of 
messages will be checked for and retrieved from the BBS.  The three 
message types are: Private, NTS, and Bulletin. 

17. Retrieval Automation.  You can configure Outpost to run a TNC Session 
automatically at a specific time interval set (in minutes).  

18. Station Identification.  The Station ID (Call Sign) can be changed. 
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1.6 The Outpost Operating Environment 
Outpost can operate in a number of packet environments where one or more BBSs 
are used as message drops (Star network).  For instance, it may be operating in a 
network along with other Outpost users or other terminal emulator program users 
with a system running BBS software.  In Santa Clara County, W6XSC-1 is the 
county�s packet BBS system serving several San Francisco South Bay Area City 
EOCs. 
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Figure 4: Central BBS Station serving many Packet users 

Outpost could also be operating in a smaller closed packet network where one user 
has enabled a TNC�s Personal BBS (PBBS) feature thereby providing a low cost 
central message drop for several stations.   
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Figure 5: A PBBS Station as a central mail drop 
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1.7 What Outpost does not do 
� Outpost does not support the any of the bulletin board forwarding protocols.  

Instead, it automates sending commands and interprets the returning 
prompts of both the TNC and the BBS to manage message handling. 

� Outpost does not support any of common email protocols such as POP3 or 
SMTP. 
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2 Installation 
2.1 System Requirements 

Outpost has been verified to run under the following Microsoft Windows 
environments: 

� Windows 98, NT, 2000, ME, and XP 

2.2 Hardware Requirements 
MS-Windows requires the following hardware: 

� Intel-based PC required to support any of the above MS Window Operating 
Systems 

� Open Serial Port for Serial or AGWPE interfacing, or  
� USB port with a serial adaptor to connect to the TNC 
� Network interface for Telnet interfacing 

2.3 BBS Requirements 
While Outpost should work with most BBS�s currently available, it has not been 
tested with them all.  There are two requirements that must be met for a successful 
Outpost implementation: 

1. BBS Prompt uniqueness.  Outpost looks for and responds to the BBS prompt as 
the means for triggering its next action.  If this uniqueness cannot be reasonably 
assured (that is, the prompt character or string can not show up as a part of the 
message text), Outpost will not behave correctly. 

2. BBS Message listing.  Outpost supports the following message list formats as 
presented by these BBS software applications or PBBS�. 

AA4RE  BBS 
Msg# TR  Size   To         From   Date/Time Subj 
 207 PY  1004 WA6ZTY       KN6PE  0712/0505 NTS Message 
 205 PY   456 WA6ZTY       KN6PE  0703/1809 Field Day 

F6FBB  BBS 
Msg#   TSLD  Dim  To    @ BBS   From   Date/Time Title 
117    PNL     23 KR6CO         KN6PE  1212/1302 New info 
385    T$L    141 95014 @NTSCA  KN6PE  1230/0957 QTC 1 … 

MSYS  BBS 
MSG # TR  SIZE TO     FROM    @BBS    DATE    TITLE 
 1244 PN    85 N9AAA  KB9BBB   W9WK  040208  NTS Message 
 1243 PN   190 N9AAA  KB9BBB   N6NKO 040208  EOC Status 

N0ARY BBS 
 Msg#  Stat  Size      To       From  Cnt Date/Time Subject 
 31704 P      327  KN6PE@N0ARY  KN6PE   0 0925/0921 CUP108:  
 31653 P  B   208  KN6PE@N0ARY  KE6AFE  1 0924/0433 KI msg 

SALLY  BBS 
 Msg# TSD  Size  To    @BBS   From   Date    Subject 
  147 BW    4084 DX    ARL    W1AW   17/Jun  ARLD024 DX  
  183 BW   22528 DX    WW     KB8NW  20/Jun  DX Bul No. 714 

KPC-x  PBBS 
MSG#  ST SIZE  TO     FROM   DATE             SUBJECT 
45    PN 148   K6TEN  KN6PE  02/26/04 23:36:23  Radio Test 
44    PN 152   KR6CO  KN6PE  02/26/04 23:36:03  Creek Watch 
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AEA-, DSP-232  PBBS 
Msg#    Size To     From  @ BBS  Date       Time   Title 
  6 PY   222 KR6CO  KN6PE        12-Dec-04  10:38  New info 

 

The key differences between the above listings are the date and time format and the 
occasional requirement for an @Route.  If your BBS message listing matches any of 
the above, Outpost will work fine.  If it does not, please send me a sample listing for 
evaluation and consideration as an enhancement request. 

2.4 Updating to Outpost 2.0.4 
Outpost 2.0.4 is data file compatible with Outpost 2.0.  Before proceeding, verify 
that Outpost 2.0 is installed.  If not, perform the steps in the following sections first. 

The Outpost 2.0.4 update comes in a zip file that includes 4 new executables, an 
ARL data file, and readme.txt file.  To update Outpost 2.0, proceed as follows: 
1. Download Outpost204u.zip to a local temp directory.  Unzip the files. 
2. Copy the 6 unzipped files to the existing Outpost program directory. 
3. Run Outpost as usual. 

2.5 Upgrading to Outpost 2.0 from Outpost 1.3 
If you have Outpost 1.3 or greater, you should UNINSTALL any of these versions 
before installing version 2.0. 

This installation will overwrite all configurations and messages that you may have 
in any previously installed version of Outpost.  If you DO NOT WANT to preserve 
the messages that you currently have, skip to Section 2.5 below.  Otherwise, 
proceed as follows.  
1. From v1.3.x Outpost, press File->Export 
2. Choose either All Folders… of the This folder… to export.   
3. Enter a file name, press OK 
The messages are now in the export file. 

2.6 Software Installation from an Internet Download 
Installing the software off the Web begins by downloading the zip file to your PC.  

1. Create a Temp directory on your PC such as optemp (or an existing temp 
directory will work fine). 

2. Navigate to the website (www.CupertinoARES.org/projects/outpost), then 
select Outpost v2.0 for downloading.  

3. Right click on the link, and select �Save Target As�.  Enter a directory to save 
the ZIP file to your temp directory. 

4. Run PKZIP or other extract program to extract the files. 

5. Click on setup.exe,  

6. Some Outpost application files may be newer than those residing on your 
system.  If prompted to "keep existing files," press "NO TO ALL."  

7. Some system files may be replaced.  If so, you may be prompted to reboot your 
computer.  Accept the request to RESTART the computer.  After the computer 
reboots, you will have to re-start Setup to continue (Step 5 above).   

8. Accept all prompts by pressing NEXT, OK, or FINISH.  The software will 
install automatically. 
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2.7 Creating and using an Installation CD-ROM 
You can create an install CD-ROM by copying the unzipped files to a CD.  See 
your specific system instructions for creating a CD-ROM.  Once the CD is created: 

1. Insert the Outpost CD-ROM into the computer.  

2. On the Task Bar, select START, select RUN.  Enter the command D:\ setup.exe, 
where �D� is the CD-ROM Drive (use the appropriate letter if your system�s 
CD-ROM is different). 

3. Some Outpost application files may be newer than those residing on your 
system.  If prompted to "keep existing files," press "NO TO ALL."  

4. Some system files may be replaced.  If so, you may be prompted to reboot your 
computer.  Accept the request to RESTART the computer.  After the computer 
reboots, you will have to re-start Setup to continue (Step 2 above).   

5. Accept all prompts by pressing NEXT, OK, or FINISH.  The software will 
install automatically. 

All system software is now loaded and the system is ready for use.  Refer to the 
other sections in this manual for information on configuring and controlling the 
Outpost application. 

2.8 Creating and using Installation Floppy Discs 
You can also create a set of install floppies as well.  To use an installation floppy 
disk set, proceed as follows: 

1. Unzip the download file.  

2. Label 2 floppies as "Outpost v2.0 Disc 1" and "Outpost v2.0 Disc 2"  

3. Copy the following 3 files to Disc 1:  
 - Setup.exe 
 - Setup.lst 
 - OutPos1.CAB 

4. Copy the 4th file to Disc 2:  
 - OutPos2.CAB 

5. Insert Disc 1 in the target machine and run a:\setup.exe. 

6. The installation program will prompt for Disc 2 when needed. 

7. Some Outpost application files may be newer than those residing on your 
system.  If prompted to "keep existing files," press "NO TO ALL."  

8. Some system files may be replaced.  If so, you may be prompted to reboot your 
computer.  Accept the request to RESTART the computer.  After the computer 
reboots, you will have to re-start Setup to continue (Step 5 above).   

9. Accept all prompts by pressing NEXT, OK, or FINISH.  The software will 
install automatically. 

All system software is now loaded and the system is ready for use.  Refer to the 
other sections in this manual for information on configuring and controlling the 
Outpost application. 

February 2006 11



Outpost Packet Message Manager v2.0.4 
Users Guide 

2.9 Operating System Considerations 
Outpost has the capability of independent operation where it will periodically poll 
the BBS for any new incoming message traffic.  Because of this feature, the PC can 
run unattended. 

However, this absence of any user interaction may cause the PC to think that it is 
idle and may invoke any enabled power management features (such as �Turn off 
Hard Disks,� �System Standby,� etc.).   

If you intend to run Outpost unattended, set these features to NEVER or OFF.  
Theses properties should be accessible from the Control Panel.   

Additionally, depending on your hardware, specific BIOS setting changes may also 
have to be made. 

Figure 6: Sample Power Option Setup Menu on a Windows XP System 
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3 Getting started 
 

As a message-centric mail handler, Outpost manages and controls all aspects of the 
message send and receive process.  This Section describes how to use Outpost. 

3.1 Station Logon Window 
When you start Outpost, you are presented with the Station Identifier window that 
displays the Station Call Sign and name of the Call Sign owner that was entered the 
last time Outpost was run.  If this information is still valid, then press OK to 
continue.  If your call sign and name are different from what is listed, enter your 
FCC call sign and name in the fields, then press OK.   

 

Figure 7: Station Identifier Window 

The field below the User Name is the Tactical Call field.  Some BBSs require the 
user to also log in with a Tactical Call.  This identifier is usually coordinated 
through the local ARES/RACES organization or BBS coordinator.   

If the currently selected BBS requires a Tactical Call, then this field will be enabled 
and you should enter your assigned Tactical Call.  If the BBS does not require a 
Tactical Call, then the field is disabled and cannot be changed.  See �Section 5 
Setting up a BBS.� 

 

Figure 8: Station Identifier with Tactical Call Sign 

The Station Identifier window will also be displayed when: 

� The user selects Change Station ID from the Setup Menu, or 
� A BBS that requires a Tactical Call is selected. 

NOTE:  You can also configure Outpost to NOT display this in the event you start Outpost 
automatically on a re-boot.  See the section on configuration settings. 
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3.2 The Main Outpost Window 
You can manage your messages, perform application setups, and control your 
Send/Receive Sessions from the Main Outpost window. 

This window has one main view that allows the user to review messages stored in 
several different folders.  The form is divided into four primary areas:   

Title, Menu,
Toolbar

Folder shortcuts

Message list
area 

Status bar

Title, Menu,
Toolbar

Folder shortcuts

Message list
area 

Status bar

Figure 9: Main Outpost Window 

3.3 Menus and Toolbars 
The Program Controls portion of the Main User Interface controls the operation and 
execution of all program tasks.    

Figure 10: Main Screen Menu and Tool Bar 

The Outpost menus provide different options for setting up and controlling the 
application.   

NOTE:  Some of the more common menu items are also implemented as Tool Bar buttons.  
See the associated menu item below for the description. 

 
Menus Description 
File New Message:  Opens a new message window for 

creating a message.  
Save As:  Saves the highlighted message to an ASCII text 
file. 
Save As, No Headers:  Saves the body of the 
highlighted message to an ASCII text file without the 
message headers (From, To, Date, Subject).  See the 
General Settings menu for information on enabling this 
feature. 
Save All:  Saves all the messages in the current folder to a 
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Menus Description 
single ASCII text file.  Messages are separated by a header 
line and a Form Feed character, thereby allowing this file 
to be sent directly to a printer for bulk printing. 
 
Export:  Writes the message database to a �*.oaf� 
(Outpost Archive) file.  This file can be later used for 
importing messages back into Outpost. 
A submenu allows the user to select messages from either  
All Folders, or This Folder (the currently selected folder). 
Import:  Reads the file created by the Export function.  
Messages are loaded back in the same folder from which 
they originated. 
Delete all Messages:  Deletes all messages in all 
folders.  This function can be performed any time, but 
probably after performing a full or partial export of 
messages to an archive file.  When selected, the user will 
be prompted whether they want to continue.   
 
Change Folder:  displays a sub-menu of all the available 
folders.  Clicking on a folder name will display messages 
stored in that folder.  These folders are: 
� In Tray 
� Out Tray 
� Sent Msgs 
� Archive  
� Draft Msgs 
� Deleted Msgs 
 
Print.  Allows the user to select a printer, then print the 
currently highlighted message to the printer. 
Print Setup.  Allows the user to select a default printer 
for Outpost.  
Exit:  Causes the program to exit. 
 

Edit Delete.  Deletes the highlighted message from the current 
folder.  If the selected folder is the �Deleted Msgs� folder, 
the user is prompted to confirm the delete request, and then 
the message is permanently deleted. 
Move to Folder.  Moves the highlighted message to 
other folder specified by the sub-menu choice. 
Copy to Folder.  Makes a copy of the highlighted 
message to other folder specified by the sub-menu choice. 
 

Setup TNC.  Manages the different interface methods � TNCs, 
AGWPE, and Telnet.  The user can select or update an 
existing interface and associated parameters, or create a 
new interface entry by entering the TNC prompts and 
commands.   
See Section 4.1 for more information. 
BBS.  Manages the list of available BBSs.  The user can 
select or update an existing BBS, or create a new BBS 
entry by entering the BBS prompts and commands.   
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Menus Description 
See Section 5 for more information. 
Change Station ID.  Allows the user to change the call 
sign and user name (and if required by the BBS, the 
Tactical Call) to be used for logging on to the BBS. 
 
 

Tools Send/Receive Settings.  Sets various parameters to 
control each send/receive session, including: 
� Automation.  Selects one of the 4 methods for 

scheduling Packet Sessions.   
� Retrieving.  Selects which messages are to be 

retrieved from the BBS (Private, NTS, and/or 
Bulletins, or those which match a specific filter).   

� Receiving.  Selects how Outpost behaves when a 
message is received. 

� Other.  Allows the user to hide the TNC Session 
window when the Session runs. 

 See Section 10 Customizing the Packet Session for more 
information. 
Message Settings.  Sets various conditions to control 
how messages are handled, including: 
� Various settings for handling New Messages including 

defining the default Message Type.  (Private or 
Bulletin), option to set a Default Destination, and an 
option to automatically insert a message number in the 
Subject Line 

� Handling Replies and Forwards.  Selects how the 
message type for these messages is established and 
how the source message form behaves if it is 
subsequently replied to or forwarded. 

� Tracking Messages.  Default settings that cause 
Outpost to request Delivery and/or Read Receipts 
from the receiving station, set up Auto-replies. 

� Prompt control for permanently deleting messages 
from Outpost. 

See Section 8, Customizing Message Settings for a full 
description. 
Report Settings.  Allows the user to set up report values 
that will be substituted into a message when an Online 
Report is loaded. 
See Section 12, Online Reports for a full description. 
Directory Settings.  Allows the user to define specific 
directories used by Outpost. 
See Section 0, Other First-Time Setups for a full 
description. 
Log Settings.  Two settings that help with some 
debugging TNC or BBS problems when they pop up. 
General Settings.  Various options to control whether 
the Station ID input form is displayed at startup, or 
whether SaveAs, No Headers is enabled as an option 
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Menus Description 
TNC Session Counter Reset.  The session counter is 
displayed in the TNC Session Log.  This command resets 
the counter back to zero. 
Empty “Deleted Items” Folder.  Deletes all messages 
in the �Deleted Items� Folder.  Once deleted from here, 
they�re gone for good. 
Reset Column Widths.  Restores the Message List 
Display columns to a default size.  This option is great for 
unhiding previously hidden columns. 
Pack Column Widths.  Forces the Message List Display 
columns to align to the column content. 
Interactive Packet.  Brings up a packet window that you 
can use to directly interact with the BBS (outside of a 
Packet Session) by either a Serial Port device (TNC), 
AGWPE, or Telnet. 

Actions Send/Receive.  Initiates a TNC message Session with 
the selected BBS. 
New Mail Message.  Opens a new message window for 
creating a message.  
Open a Message.  Opens the currently highlighted 
message in the message list. 
 

Help Outpost Help.  There is no On-line help system 
available.  This option points you to this User Guide. 
About Outpost.  Description of this program. 
 

3.4 Folders and Shortcuts 
Outpost manages its messages in 6 different folders.  Once a folder is selected, the 
contents of that folder are displayed and the selected folder name is shown above 
the message list area. 

 
Folders Description 
In Tray Messages retrieved by Outpost�s Packet Session Manager 

from the BBS are placed in the In Tray.   The Date/Time 
field is set to the time the message originally was sent to 
the BBS. 
 

Out Tray On creating and sending a message, the message is saved 
in the Out Tray.  The Date/time is set to �none.�  Messages 
in this folder can be opened, viewed, edited, and saved 
back to this location. 
Only valid messages can be sent.  A valid message 
includes a message with all fields filled in. 
Outpost�s Packet Session Manager checks this folder for 
messages addressed to the currently selected BBS and 
sends these messages regardless of type (Private, Bulletin, 
and NTS).   
Once a message is sent to the BBS, the message is moved 
from the Out Tray to the Sent Msgs Folder with the date 
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Folders Description 
and time set to the time it was sent. 
 

Sent Msgs Once a message is sent to the BBS from the Out Tray, it is 
moved to the Sent Folder.  The Date/Time field is set to 
the time the message was sent to the BBS.   
Messages in this folder can be opened, viewed or 
forwarded to another BBS user. 
 

Archive The Archive is an ad hoc message folder. 
 
 

Draft Msgs This folder contains messages that are not complete.  Only 
a Subject is required to Save a message to this Folder. 
 

Deleted Msgs This folder contains all messages previously deleted from 
all other folders.   
Messages in this folder can be opened, viewed, forwarded, 
replied to, or moved or copied to the Archive Folder. 
Deleting a message from this folder permanently deletes it 
from Outpost. 

3.5 Message List Area 
The message list area is where messages residing in the selected folder can be 
selected. 

Unread messages in the In Tray will be displayed with BOLD text.  Once a message 
is read, it will be re-displayed with regular (unbolded) text. 

After selecting a folder, only messages stored in that folder are displayed.  The 
message list area displays the following fields: 

 
Field Description 
U Urgent Flag.  Messages sent to this station from another 

Outpost v1.3 (or later version) system can be sent as 
URGENT.  When these messages are received, they are 
indicated by two RED �!!� in the �U� column and the 
message list displayed in RED. 
See the Message Form for the control to set a message as 
URGENT. 
 

Type This field indicates the message�s type and can contain one 
of the following 3 values: 
� (blank) Private Message 
� B  Bulletin 
� NTS National Traffic System Message 
 
The Message Type is set either by the sender or manually 
through the Message Edit window, based on the message 
type options available as Message setup options (Tools > 
Message Settings). 
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Field Description 
From The originator of this message.   

This field contains either an FCC Call Sign (current station 
ID) or Tactical Call as assigned by the BBS SYSOP. 
 

To The destination of this message.   
For messages created in Outpost, this field contains the 
FCC Call Sign or Tactical Call of the recipient.  This field 
could also contain a valid formatted NTS address or a 
tactical call sign if the BBS requires one. 
The To Field can also hold a full hierarchical address for 
forwarding beyond the BBS.  This is in the form (i.e.): 
KN6PE@N0ARY.#NOCAL.USA.NOAM. 
For messages received from the BBS, this field will match 
Outpost�s currently set Station ID. 
 

BBS The currently selected BBS.   
For messages created in Outpost, this field contains the 
name of the BBS that was set when the message was 
created, and where this message is intended to be sent.  
This allows messages to be created for users on different 
BBSs, and not sent until the BBS is selected using the 
Setup > BBS menu. 
For messages received from the BBS, this field lists the 
BBS from where the message originated. 
 

Subject The subject of the message.  On opening the message, the 
entire 80-character subject line is displayed. 
NOTE: most BBS�s have subject lengths are a lot shorter 
than this.  It is recommended to keep your subject lines 
brief so they do not get inadvertently truncated in a manner 
you did not desire. 
 

Date / Time The message Date / Time. 
For messages created and saved in Outpost (stored in the 
Draft folder) or Sent (stored in the Out Tray), this field 
will be set to �None.�   
After a message is sent to the BBS, the message is moved 
to the Sent folder and the date/time is set to the time the 
message was sent to the BBS. 
For message received from the BBS and stored in the In 
Tray, this field is set to the date/time that the message was 
posted on the BBS. 
 

Size Size of the message in Bytes.  Outpost has a hard limit of 
10,000 characters per message.  All originated and 
received messages will be limited to this size. 
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3.6 Status Bar 
The status bar is displayed at the bottom of the window.  This area displays the 
following information. 

 

Figure 11: Status Bar, BBS does not require a Tactical Call 

 

 

Figure 12: Status Bar, BBS requires a Tactical Call 

 
Item Description 
Message Count Displays the number of messages in the selected folder, 

and the number of messages currently in all folders 
(includes messages in the �Deleted Msgs� folder). 
 

Current Setup Displays the station call sign, the currently selected 
TNC, and the currently selected BBS. 
If the selected BBS requires a tactical call, then that is 
listed after the station call sign as seen in the 2nd 

example shown above. 
 

Time until next 
Packet Session 

When Send/Receive automation is selected, this timer 
shows the number of hours, minutes, and seconds left 
until the next Send/Receive Session is initiated. 
If the timer shows 00:00:00, then no automation is 
selected. 
 

Current Time The current system time in 24-hour format. 
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3.7 Customizing the Display 
Outpost lets you to change the widths of the columns, or hide a column if it is not 
required for viewing.  

Figure 13: Resizing a column 

To change a column width:  

1. Put the mouse cursor on the right side of a column Header�s dividing line for 
the column you want to change size. 

2. Left Click, hold the mouse button down, and move the mouse left to reduce the 
column size or right to increase the column size. 

3. To hide a column, move the mouse all the way to the left until the field is 
hidden. 

4. Double-click on the dividing line will automatically resize the column to the 
widest text in the column. 

There are also two column re-sizing features found on the Tools menu: 

▪ Reset column widths:  Resizes the columns to a default size. 

▪ Pack column widths:  Resizes the width of all columns to a width of the 
widest text in each column for the current display. 

Figure 14: Resetting column widths 
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3.8 Getting ready to set up Outpost 
In most cases, the steps involved with setting up Outpost need only to be performed 
once.  All setup options are stored in initialization or data files.  There are 4 things 
that must be set up or at least checked prior to running your first TNC Session.  
These are: 

� Choose an interface type and define the device 
� Configure the BBS 
� Register on the BBS 
� Confirm the user mode on the BBS 

In preparation for defining these configurations, it is helpful to have any hardware 
and BBS documentation that may be available.  If none can be found, manually 
interacting with the TNC and the BBS is the next best way to confirm you have 
entered these configurations correctly.   

In most cases, there are default settings that can be used when defining a TNC or 
BBS.  However, there is some information that is TNC and BBS specific that must 
be understood in order to complete the setup step. 

These items are covered over the next 2 chapters in this guide.   
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4 Setting up Interfaces 
 

Outpost can communicate to a BBS by one of three interface types: direct serial port 
with a TNC, an AGWPE-controlled TNC or other device, and by a telnet 
connection.  Setting up the interface is the first step that you must do. 

4.1 Defining the Interface Type 
The big change with Outpost 2.0 is the addition of AGWPE and Telnet as additional 
interface devices that can be configured and used.  Direct Serial Port TNCs still 
work as before.  Because of these additions, the layout of the TNC Setup form is 
expanded to accommodate these new interfaces. 

Depending on the type of interface that you select, the corresponding tabs will be 
enabled.  In the example below, the AGWPE and Telnet tabs are disabled because 
the Device Type is a Direct Serial Port TNC. 

Outpost comes with examples of different interfaces already set up.  Please use 
these as references when picking and defining a new interface. 

 

 

Figure 15: Interface Type Setup 
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Device settings are managed from a series of tabs across the top of the above menu.  
These tabs are: 

Tabs Description 
Interface Type This tab is used for all interfaces.  It allows the user to 

select a previously defined configured interface, or 
define a new one.  See the field descriptions below. 
 

TNC Prompts Enabled for a TNC connected to a Serial Port.  Contains 
the definitions of what the TNC prompts look like. 
 

TNC Commands Enabled for a TNC connected to a Serial Port.  Contains 
the definitions of the different commands Outpost uses 
to talk to the TNC. 
 

TNC Comm Port Enabled for a TNC connected to a Serial Port.  Defines 
the serial port configuration for the TNC. 
 

AGWPE Enabled for an AGWPE interface.  Defines the 
parameters needed for Outpost to talk to the AGWPE 
monitor program.   
 

Telnet Enabled for a Telnet interface.  Defines the parameters 
needed for Outpost to talk to the BBS that is Telnet-
accessible. 
 

 
On the Device Type Tab, the following controls are available: 

Fields Description 
Device Name A Pull-down menu of the TNCs or interfaces previously set 

up in Outpost.   
Default: Last TNC/interface selected 
 

Device Name When creating a new TNC or interface entry, the Pull-down 
tab is hidden and the fill-in-the-blank Device Name field is 
where you enter the name of a new TNC or interface.   
While this is usually the TNC Model Number (i.e.: KPC-3), 
it can be some other description such as KPC3-P0 (port 0), 
Jims-KPC3+, etc. 
The name can be up to 20 characters long. 
 

Description This is a free-form text field for entering any additional 
information about this TNC or interface.   
This is a 256 character field. 
 

Device Type Displays the device type for the selected TNC.  When 
creating a new entry, allows the user to pick the interface 
type they want to configure. 
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The following menu controls are available: 
Controls Description 
New Allows the user to set up a new interface type.  All fields 

throughout the menu are set to their default settings. 
 

Delete Allows the user to delete the currently displayed TNC or 
interface.  The user will prompted whether they really want 
to delete the interface. 
 

OK Same as Apply, but closes the menu on completion if the 
validation is successful. 
 

Cancel Cancels any changes that may have been made to the form. 
 

Apply Causes all required fields to be validated as being filled in.  
On completion, the menu remains open.  The Apply control 
becomes enabled as soon as any field is changed as caused 
by an update to an existing configuration or by creating a 
new TNC or interface.   
 

4.2 Serial Port TNC Setup 
A "Terminal Node Controller" (TNC) connects your computer to your radio, similar 
to how a dial-up modem connects your computer to the Internet.  Most TNCs 
implement some or all of the command-set defined by TAPR (Tucson Amateur 
Packet Radio Club).  Outpost uses these commands as the default commands when 
setting up your TNC.  If your TNC�s command-set is different, you can change 
them when you define a new or update an existing TNC. 

 

 

Figure 16: TNC Setup Menu 
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There are 3 tabs that are enabled to define the Serial Port TNC.: 

The TNC Prompts menu contains fields for the prompts that the TNC will send 
back letting Outpost know what kind of response it got from the TNC.  On creating 
a new TNC, the default prompts as shown below are loaded, and should work fine 
for all TNCs.  Check your TNC manual if system hangs occur.   

 

Figure 17: TNC Prompts Setup Menu 

The fields on the form are as follows: 
 

Fields Description 
Command The prompt that the TNC displays to prompt for the next 

TNC command.   
Default: cmd:  (TAPR standard prompt) 
 

Timeout The string that is displayed by the TNC when the number of 
configured retries is exceeded.   
Default: *** retry count exceeded 
 

Disconnected The string that is displayed by the TNC whenever the TNC 
unexpectedly disconnects from the BBS.  This is usually 
caused if the BBS terminates the connection, or the user 
forces a disconnect.   
Default: *** DISCONNECTED 
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The TNC Commands menu contains the commands that Outpost needs to issue to 
the TNC to prepare for and connect to the BBS.  On creating a new TNC, the 
default prompts are loaded, and should work for all TNCs.  Check your TNC 
manual if system hangs occur.   

 

Figure 18: TNC Commands Setup Menu 

The fields on the form are as follows: 

 
Fields Description 
Mycall The TNC command that is used to set the station ID.  When 

entering this command, only enter the TNC portion of the 
command.  Do not include the station ID. 
Default: mycall 

Connect The TNC-only command that initiates a connection with a 
BBS.  When entering this command, only enter the TNC 
portion of the command.  Do not enter the BBS callsign.   
Default: connect. 

Retry The TNC command that determines the number to attempts 
the TNC will transmit a packet to the BBS before giving up. 
.   
Default: retry 

Reset The TNC command that performs a soft reset of the TNC. .   
Default: reset 

DateTime The TNC command that is used to set the date and time.  
This command is transmitted each time a TNC session is 
initiated.   
Default: daytime 
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The TNC Comm Port menu defines the serial port settings for the TNC.  On 
creating a new TNC, an initial setting is loaded, but should be carefully checked 
against the serial port configuration for the TNC you have set up.   

 

Figure 19: TNC Comm Port Setup Menu 

Comm Port settings are standard serial port settings typically used by other terminal 
emulator programs.  These settings define: 

 
Fields Description 
Port Identifies the Serial Port to which the TNC is connected.   

Default: 1  
 

Max Speed This is the baud rate between the computer and the TNC.  
This is different from the speed that the TNC transmits data 
to the BBS.  Outpost Baud Rate settings include: 
110   19200 
300   28800 
600   38400 
1200   56000 
2400   57600 
4800   115200 
9600   128000 
14400   256000 
 
Default: 9600 
 

Data Bits The number of data bits to be sent.   
Default: 8 
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Fields Description 
Parity Defines how parity will be handled  

Default: None 
 

Stop Bits Default: 1 
 

Echo Sends an Echo On of Echo Off command to the TNC.  
When set to On, all commands sent to Outpost will be 
�echo�ed� on the Packet Session Manager window. 
Default: On 
 

Flow Control Determines how the program will manage the data flow 
between the Computer and the TNC.  The following options 
are available: 
� None: no flow Control is used 
� RTS/CTS: Hardware flow control 
Default: RTS/CTS 

 Comments on Flow Control 
Flow Control (also known as Handshaking) is a way for data communication 
equipment to control the flow of data between connected equipment, particularly 
when one part of the system is slower than the rest.  This is the case with the TNC 
and BBS.  While the PC running Outpost can connect and transfer data to the TNC 
at a high data rate (such as 9600 baud in the example above), the TNC is limited to 
transmit at 1200 baud (or 9600 baud if your configuration supports it) with the BBS.   

Because Outpost generates all the commands that you would typically enter, it 
communicates with the TNC at a significantly faster rate than what you could 
manually type.  Therefore, there is the risk that Outpost will overflow the TNC�s 
internal transmit buffer.  When this happens, the TNC and the Packet Session 
Manager will hang. 

The default setting is RTS/CTS (Hardware Flow Control).  For this option to work, 
you must have a serial cable between the TNC and Computer with at least the 
additional CTS pin connected.  To make it easy, I recommend using a full 9 pin 
cable.  If you have only a Pin 2 and 3 cable, leaving this setting as is will not have 
any adverse affect.  However, no flow control will occur. 

WARNING!  Unshielded home-made cables are a known source of problems that can cause 
system and PC hangs.  Most commercial cables are shielded.  If you decide to make 
your own, ensure the cable is shielded, or else RF will get into your computer. 
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4.3 AGWPE Setup 
Per Ralph Milnes KC2RLM, "AGWPE is a multi-TNC management utility written 
by George SV2AGW.  Before AGWPE, a packet device such as a TNC or other 
radio modem could only be used by one program at a time.  Likewise, a packet 
program could only use one packet device at a time.  AGWPE changed all that.  It 
lets a program access multiple packet devices at one time, and lets a packet device 
be shared by multiple programs at one time. 

"AGWPE performs this magic by placing the TNC in KISS mode and assuming 
responsibility for handling most of the logic functions built into the TNC.  The TNC 
is left to handle just tone modulation/demodulation, or modem functions. AGWPE 
also works with radio modems, such as the YAM and Baycom that already lack 
logic functions and must rely on the logic functions of a control program such as 
AGWPE." 

NOTE:  For users wishing to use AGWPE, I strongly recommend that you thoroughly 
understand how AGWPE works, how it is set up, and how it is confirmed 
operational before deploying it with Outpost.  AGWPE support is a field of study 
unto itself and therefore, is out of scope for Outpost support.  However, there is 
plenty of help available from users on the Internet. 

Outpost implements the required protocol to talk to AGWPE and its associated TNC 
device located either on the same PC where Outpost is running or on a remote PC 
somewhere else on the network. 

The AGWPE setup form is enabled once AGWPE is selected as the device type. 

 

Figure 20: AGWPE Setup Menu 

The AGWPE menu manages information specific for accessing the AGWPE 
program.  On defining a new AGWPE Interface, the default values shown above are 
loaded, and should work for a locally configured (same PC) AGWPE installation.  
The fields on the form are as follows: 
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Fields Description 
Remote Host The IP Address or host name of the PC where AGWPE is 

running.  The default setting tells Outpost to look for the 
AGWPE on the machine where Outpost is running. 
Default: 127.0.0.1 
 

Remote Port Ports are used with TCP to name the logical connection on a 
specific network node.  The default AGWPE port is 8000.  
This setting must match what is set up in the AGWPE 
Winsock Interface form. 
Default: 8000 
 

Network 
Timeout 

The network timeout tells Outpost how long to wait for a 
network interaction with AGWPE before it gives up and 
reports an error.  A setting of 5000 (5 seconds) is plenty, 
particularly if AGWPE is operating on the same PC as 
Outpost. 
For remote instances of AGWPE, the timeout may need to 
be longer depending on the network traffic. 
Default: 5000 
 

TNC 
RadioPort 

Corresponds to the TNC Radio Port setting defined on the 
AGWPE Radio Port TNC Setup 
 

AGWPE 
Logon 
Required 

This and the next 2 fields depend on whether a logon 
requirement was defined at the AGWPE program.   
For AGWPE operating on the same PC as Outpost, no 
Logon is required.  Logon is optional for cases where 
AGWPE is located somewhere else on the same LAN, or 
elsewhere on the internet. 
Check this box is a Logon is required. 
Default: unchecked (not required) 
 

Logon If the AGWPE Logon box is checked, this field is enabled.  
The logon name entered here must match the name set up in 
AGWPE. 
Check the AGWPE configuration for a Logon /password 
requirement (AGWPE�s Winsock Interface Security tab). 
Default: no entry 
 

Password If the AGWPE Logon box is checked, this field is enabled.  
The password entered here must match the name set up in 
AGWPE. 
Check the AGWPE configuration for a Logon /password 
requirement (AGWPE�s Winsock Interface Security tab). 
Default: no entry 
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4.4 Telnet Setup  
There are a few BBSs that can be accessed by Telnet.  Outpost v2.0 now supports 
this type of access.   

Similar to the AGWPE, setting up telnet requires an understanding of the network 
settings that need to be defined.  Unlike AGWPE, Telnet access to a BBS is usually 
more tightly controlled resulting in the need to work with the BBS Sysop to 
establish a telnet logon and optional password.  This ensures non-Hams cannot 
initiate traffic on the Amateur Radio bands. 

The Telnet setup form is enabled once Telnet is selected as the device type. 

 

Figure 21: Telnet Setup Menu 

The Telnet menu contains information specific to accessing the remote BBS over a 
LAN or WAN.  On defining a new Telnet Interface, some default values are loaded, 
but will be insufficient to operate without additional information.  The fields on the 
form are as follows: 

 
Fields Description 
Remote Host The IP Address or host name of the server where the BBS is 

running.  The default setting tells Outpost to look for the 
BBS on the machine where Outpost is running.  Contact the 
BBS Sysop for the IP Address or Host name. 
Default: 127.0.0.1 
 

Remote Port Ports are used with TCP to name the logical connection on a 
specific network node.  Contact the BBS Sysop for the Port 
number for the BBS. 
Default: 0 
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Fields Description 
 

Network 
Timeout 

The network timeout tells Outpost how long to wait for a 
network interaction with the BBS server before it gives up 
and reports an error.  A setting of 5000 (5 seconds) is 
plenty, particularly if server is operating on the same LAN 
as Outpost. 
For remote instances of the server, the timeout may need to 
be longer depending on the network traffic. 
Default: 5000 
 

Logon 
Prompt 

This is the string presented by the BBS that prompts for the 
Logon Name. 
Default: Callsign : 
 

Password 
Prompt 

This is the string presented by the BBS that prompts for the 
password. 
Default: Password : 
 

Logon This is the answer to the Logon Prompt.  Contact your BBS 
Sysop for the logon information.  Usually, this will be your 
call sign 
Default: no entry 
 

Password This is the answer to the Password Prompt.  Contact your 
BBS Sysop for the logon information.  Usually, this will be 
set up by the Sysop. 
Leave this field BLANK if there is no password assigned to 
access the BBS by Telnet (not recommended). 
Default: no entry 
 

 

4.5 Selecting a previously configured interface 
Outpost comes with a few commonly available TNCs, and sample AGWPE and 
Telnet interfaces already configured.  To select one of these configured TNCs, 
perform the following:  

1. From Outpost�s main form, select the Setup menu, then TNC.  If a TNC 
was previously defined, it will be displayed. 

2. At the TNC Name: field, use the pull-down menu to view the currently 
defined TNCs. 

3. Select the TNC you want to use.   

4. Press OK when done.  This TNC is now selected as the default TNC. 

When done, Outpost will display the selected TNC on the Status Bar on the bottom 
of the Main Form.  
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4.6 Updating a previously configured Device 
Most TNC settings can be changed.  To change a TNC setting, perform the 
following:  

1. From Outpost�s main form, select the Setup menu, then TNC.  If a TNC 
was previously defined, it will be displayed. 

2. All fields (other than the TNC name) can be changed.  When done, press 
Apply or OK. 

4.7 Defining a new interface 
Setting up a new Interface uses the menus described above.  Depending on the 
interface selected will determine which tabs on the menu will be enabled.   

Set up a new TNC as follows: 

1. From Outpost�s main form, select the Setup menu, then TNC. 

2. Press the New button. 

3. Enter the Device Name.  A good rule of thumb is to enter the product or 
model number for a TNC (such as KPC-3, KAM, DSP232, etc.), or some 
descriptive text for AGWPE or Telnet (such as AGWPE-LOCAL, 
CRAIGS-TELNET). 

4. Enter any additional text in the description field you want about the TNC 
(i.e.: frequency, other comments). 

5. For Serial Port TNC setups, the TNC commands are generally the same 
from one TNC manufacturer to another. 
 
Having said that, undoubtedly there is one or more TNCs on the market that 
have a different command and/or prompt set.  Because Outpost issues TNC 
commands on behalf of the user, and looks for the TNC prompts, it is 
important that the specific TNC commands and prompts required by 
Outpost are defined.  If your TNC has a different command-set or prompt-
set from what is initially loaded, then you will have to change the default 
settings. 

6. For Serial Port TNC setups, using the TNC�s reference manual, verify the 
default TNC prompts are correct, or change them as necessary. 

7. Verify the default TNC commands are correct, or change them as necessary.   

8. Verify the Comm Port settings are correct, or press the Comm Port button 
to change them as necessary (see below for the Comm Port menu). 

9. Press OK when done.  This new TNC entry and Comm Port settings are 
saved and set as the current TNC. 
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5 Setting up a BBS 
 

The next step is to define the Bulletin Board System (BBS�s).  There are some 
variations in BBS�s that require defining the BBS command and prompt set.  
Outpost uses the BBS commands to send and retrieve messages to the BBS.   

5.1 BBS Setup Menus 
Outpost comes with a few examples of different BBSs already set up.  Please use 
these as references when setting up a new BBS. 

 

 

Figure 22: BBS Setup Menu 

 
BBS settings are managed from a series of tabs across the top of the above menu.  
These tabs are: 

Tabs Description 
BBS Name This tab allows the user to select a previously defined 

BBS, or define a new one.  See the field descriptions 
below. 

BBS Prompts Contains the definitions of what the BBS prompts look 
like. 

BBS Commands Contains the definitions of the different commands 
Outpost uses to talk to the BBS. 

Message 
Formatting 

Disabled in v2.0.  This is a planned future enhancement 
to allow the user to mask BBS-generated headers and 
footers in retrieved messages. 
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On the BBS Name Tab, the following controls are available: 
Fields Description 
BBS Name A pull-down menu containing the list of BBSs currently set 

up in Outpost. 
Default: Last BBS selected  

Connect 
Name 

The exact name of the BBS to which you want to connect.  
This is NOT a friendly name (Bob�s BBS) but the call sign 
and SSID (if used) of the BBS, such as K6FB-2 or an alias 
(SEABBS).  This string will be appended to the TNC 
�connect� command. 
Default: none  Character Size: 10 

VIA (opt) Optional field.  If you are too far from the BBS to reach it 
directly, you may need to access it with an intermediate 
station.  Enter the name of the station that you will use to 
remotely connect to the BBS. 
This field can support up to 3 VIA stations. 
Default: blank  Character Size: 30  

Description This is a free-form text field for entering any additional 
information about this TNC or interface. 
Default: blank  Character Size: 256  

BBS TYPE � Most BBSs behave the same and require no special 
handling.  If you are not sure what the BBS application 
is with which you are connecting, check this option. 

� The MSYS BBS requires special handling in terms of 
prompt processing.  If this box is checked, the Subject 
Prompt and Message Prompt are populated with MSYS 
prompts. 

Default: Most BBSs� 

 

The following menu controls are available: 
Controls Description 
New Allows the user to set up a new BBS.  All fields are set to 

their default settings. 
Delete Allows the user to delete the currently displayed BBS.  The 

user will be prompted whether they really want to delete the 
BBS. 

OK Same as Apply, but closes the form on completion if the 
validation is successful. 

Cancel Cancels any changes that may have been made to the form. 
Apply Causes all required fields to be validated as being filled in.  

On completion, the menu remains open.  The Apply control 
becomes enabled as soon as any field is changed as caused 
by an update to an existing configuration or by creating a 
new BBS.   

 

February 2006 36



Outpost Packet Message Manager v2.0.4 
Users Guide 

The BBS Prompts tab contains the prompts that the BBS will send back to the 
operator letting Outpost know what kind of response it got from the BBS.  On 
creating a new BBS, you must define the BBS Command Prompt.   

 

Figure 23: BBS Prompts Menu 

The fields on the form are as follows: 

 
Fields Description 
Command The prompt that the BBS displays to prompt for the next 

BBS command.   There is no standard BBS prompt.  It is 
recommended that you copy the BBS prompt exactly so 
there is no mistake in its setup. 
Be careful about embedded spaces and capitalization in 
prompts.  For instance: Help> is not the same as Help_> . 
Default: none 

Tactical Call 
Sign required 

Check box:  Some BBSs operate with Tactical Calls.  
Similar to the way tactical calls are used in voice traffic, 
these calls allow different operators to log on and access a 
packet network while retaining the addressing of the tactical 
call.  If your BBS requires a Tactical Call and will prompt 
for one, check this box. 
Default: unchecked 

Tactical Call If the above box is checked, this field is enabled.  Enter the 
Tactical Call prompt into this field. 
Default: none 

Subj Prompt Used for MSYS BBS only.  This field cannot be changed.  
If the MSYS BBS is selected, the default MSYS Subject 
Prompt will be filled in. 
Default: POSTAL CODE if not local: 
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Fields Description 
Msg Prompt Used for MSYS BBS only.  This field cannot be changed.  

If the MSYS BBS is selected, the default MSYS Message 
Prompt will be filled in. 
Default: /EX, ^A to abort 

Unique text 
displayed… 
sends a 
message 

This field describes the string that Outpost will look for 
after sending a message to the BBS to know that the 
message was sent.  See the information on the Advanced 
Control below. 
Default: disabled, value defaults to the command prompt 

Unique text 
displayed… 
receives a 
message 

This field describes the string that Outpost will look for 
after receiving a message from the BBS to know that the 
message was sent.  See the information on the Advanced 
Control below. 
Default: disabled, value defaults to the command prompt 

 

This tab also provides the following special controls. 
Controls Description 
Advanced This control enables the following two fields for custom 

entry: 
▪ Unique Text is displayed by the BBS after Outpost 

sends a Message 
▪ Unique Text is displayed by the BBS after Outpost 

receives a Message 
These 2 fields are automatically set to the Command 
Prompt as defined above.  When a message is sent to or 
received from the BBS, it may be useful to detect a different 
string back from the BBS other than the Command Prompt.  
This feature will only work well when (i) the BBS 
command prompt is not unique enough (relative to the 
message text), AND  (ii) the alternative �message sent� or 
�message received� string from the BBS is unique enough. 
 

Default This control resets the 2 fields referenced above back to the 
Command Prompt. 
Default: disabled until the Advanced button is pressed. 

 

WARNING!  Changing these 2 fields may result in unexpected program behavior.  Be very 
careful if you decide to changes these values. 
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The BBS Commands tab contains the commands that Outpost issues to the BBS to 
send, list, receive, and delete messages on the BBS.  On creating a new BBS, the 
default prompts are loaded, and should work fine for all BBSs.   

 

Figure 24: BBS Commands Menu 

The fields on the form are as follows: 
Fields Description 
Send Private The BBS command that is used to send a Private Message.  

Only the station to which this message is addressed can read 
it. 
Default: SP 

Send Bulletin The BBS command that is used to send a Bulletin Message.  
Bulletins are usually addressed to a group of stations.  All 
stations can read bulletins.   
Default: SB 

Send NTS The BBS command that is used to send an NTS Message.  
NTS messages can be read by anyone who is willing to 
service the NTS message.   
Default: ST 

List Mine The BBS command that that produces the list of messages 
addressed to you. In Outpost, this can either be the Station 
ID (ie: KH6ABC) or the tactical call (ie: CUPEOC). 
Default: LM 

List Bulletin The BBS command that produces the list of bulletins 
present on the BBS. 
Default: LB 

List NTS The BBS command that that produces the list of NTS 
messages present on the BBS. 
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Fields Description 
Default: LT 

List Filtered The BBS command that will produce the list of messages 
that match the Filter Masks defined on the Send/Receive 
Settings menu. 
If the MSYS BBS is selected 
Default: L> for the Most BBS selection 
 L   for the MSYS BBS selection 

Read 
Message 

The BBS command that retrieves and displays a specific 
message on the BBS. 
Default: R 

Delete 
Message 

The BBS command that deletes a message on the BBS. 
Default: K 

Bye/Log off The BBS command that logs you off of the BBS. 
Default: B 

 

The Message Formatting tab is a placeholder for a feature to be introduced in a 
later release.  All fields are disabled and cannot be changed.   

 

Figure 25: Message Formatting Menu 
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5.2 Selecting a configured BBS 
Outpost comes with a few BBSs already configured that are mostly found in San 
Francisco�s South Bay Area.  For those Outpost users outside the Bay Area, please 
consider these as examples on how a completed BBS setup should look.  If desired, 
these BBS entries can be deleted from the list.   

To select a previously configured BBS, perform the following: 

1. Select Outpost�s Setup menu, then select BBS. 

2. At the BBS Name field, use the pull-down menu to view the available 
BBSs.  If a BBS was previously defined, it will be displayed. 

3. Select the BBS you want to use.   

4. Press OK when done. 

Outpost will display the selected TNC on the Status Bar on the bottom of the Main 
Form. 

5.3 Defining a new BBS 
While it would be great if all BBSs behaved the same in terms of commands and 
prompts, this is not the case.   

There are many variations of BBS firmware and software in use.  Some Personal 
BBS�s (PBBS) are implemented in TNCs, while other BBSs have been written and 
distributed by hams to users across the country. 

While Outpost has not been tested with each BBS system, the widest variation in 
BBS operation seems to be in terms of BBS prompts.  Getting the prompts right 
during the configuration will be critical to successful operation.  This may take 
some time troubleshooting in the event the BBS does not respond exactly as you 
would expect.  Set up a new BBS as follows: 

NOTE:  It is highly recommended that you can access the BBS from either the Outpost�s 
Interactive Packet Window or some other TNC program. 

NOTE:  It is critical that all prompts be entered exactly as sent from the BBS.  I�ve used 
both the Outpost Interactive Packet Window and Windows� HYPERTERM 
program to �copy� (CNTL-C) and �paste (CNTL-V) prompt strings into Outpost. 

 

1. Select Outpost�s Setup menu, then select BBS. 

2. Press the New button. 

3. Enter the Connect Name.  This is the name of the BBS as you would type it to 
initiate a connection (such as: K6FB-2, W6XSC-1, etc.).  

4. If Outpost is too far from the BBS, you can enter the call sign of one digipeater in the 
field labeled �VIA (opt).�   

NOTE:  The �VIA� field is an optional field.  If you do not intend to use a digipeater, 
LEAVE THIS FIELD BLANK.  Any miscellaneous characters will cause Outpost 
to attempt a �via� connect with these characters. 

5. Some BBS systems that support local ARES/RACES organization may also prompt 
for an additional tactical Call Sign. 
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� If your BBS requires a tactical call sign, then check the Tactical Call 
required box and enter the Tactical Call Sign prompt.  Include as much of 
the prompt as possible. 

� If your BBS does not require a Tactical Call Sign, then leave this box blank.  
6. Enter the BBS Command Prompt.  This is best determined by running your terminal 

emulator or TNC program to see exactly what the BBS sends back.  Watch for 
embedded spaces in the prompt (i.e.: �Help>� is not the same as �Help_>�).   
Outpost is case sensitive; make sure the capitalization is correct as well. 

NOTE:  Outpost uses the prompts as unique identifiers to determine when the BBS is 
waiting for the next Outpost command.  If this uniqueness cannot be guaranteed 
(i.e.: a character sequence that matches the prompt in a text message), then Outpost 
may not wait for the end of the message before sending the next BBS command. 

7. Verify the default BBS commands listed; change them as necessary.   

8. Press OK.  This new BBS entry is saved and set as the current BBS. 

5.4 BBS Registration 
The typical Outpost session assumes there are no superfluous prompts such as 
prompting for the user�s name, zip code, city, etc.  However, some BBSs set this up 
during the registration process at first time log on. 

▪ If you intend to access a BBS that requires registration, you must register prior 
to running Outpost. 

▪ If you run Outpost and the program hangs because of registration prompts, 
Press the Abort Session button, wait for Outpost to end and close the TNC 
Session Window, then register with the BBS using either Outpost�s Interactive 
Packet Window (under the Tools!Interactive Packet menu) or some other 
terminal emulator program. 

▪ Log on manually to confirm the registration was successful. 

5.5 BBS Expert User Mode 
Several BBSs provide different levels of prompts.  

▪ The NEWUSER mode presents different prompts that guide the new user 
through the use of the BBS. 

▪ The EXPERT mode assumes the user is familiar with the BBS and its 
commands, and presents only the BBS Command prompt. 

Outpost only works in EXPERT Mode and does not expect to see any other prompt 
other than the BBS command prompt.  If your BBS supports it, before beginning an 
OUTPOST Session, verify your logon is set for EXPERT. 
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6 Other First-Time Setups 
 

There are 2 other areas that are worth setting up prior to beginning with Outpost that 
are described here. 

6.1 Setting up Application File Locations 
Outpost reads and writes a series of files that are used for various purposes.  When 
Outpost is initially installed and run for the first time, it will attempt to create 3 
directories in the program directory: �archive�, �reports�, and �logs�.  These 
directories changed on the form located at Tools > Directory Settings… : 

 

 

Figure 26: File Location Menu 

When running Outpost for the first time, the default directory locations are the 
directory where the application resides.  These fields are: 

 
Fields Description 
Archive Storage location for files that are created by the message 

database export process File > Export, or by doing a  
File > Save As or a File > Save All for the messages in a 
message folder.   
While the name can be anything, the subdirectory �archive� 
is a descriptive name for this purpose. 
Default:  archive 
 

Reports The location where Outpost first looks for On-line report 
files.  Typically, the subdirectory �reports� is created for 
this purpose. 
Default:  reports 
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Fields Description 
Logs The location where Outpost writes all application and trace 

logs.  Typically, the subdirectory �logs� is created for this 
purpose. 
Default:  logs 

Various The location for other application files.  Typically, the 
application directory is used for this purpose 
Default:  Application directory 

Subdirectories can be created in one of two ways: 

1. Direct Entry.  You can type in the directory path into each field.  On 
pressing OK, a check is made to ensure the directory exists.  If it does not, 
you will be prompted to allow Outpost to create it. 

2. Directory Selection.  To find and select a directory, click on the button at 
the end of the directory entry fields.  A form pops up that will allow you to 
find and select a directory.  Press OK to load the File Location Menu, then 

OK when done. 

Figure 27: Select a directory menu 
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6.2 Setting up the Report Values 
Outpost uses a series of user-defined values to automate the message creation 
processes.  These settings are defined using the form shown here and located at 
Tools > Report Settings… : 

 

Figure 28: Report Settings Menu 

The fields in this form are defined as follows: 

 
Fields Description 
Next Message 
Number 

This is a sequential message number that can be added to a 
Message�s subject line, incorporated into an NTS message, 
or accessed by an On-line report.  Each time it is accessed, 
it is incremented to the next number. 
Default: 100 

Organization A free-form text field that can contain the name of the 
organization that you may be supporting or to which you 
belong.  Sample organization names are:  
Cupertino ARES/RACES 
Department of Health Services 

City A free-form text field that contains the name of a City.  
Typically, this could be the name of the City from which 
you are operating.  

County A free-form text field that contains the name of the County 
or district.  Typically, this could be the name of the County 
from which you are operating.   

State/Prov A 2 character text field that contains the name of the State 
or Province.  Typically, this could be the name of the State 
or Province from which you are operating. 

Tactical 
Location 

A free-form text field that contains the name of the 
Tactical Location.  Sample tactical location names are:  
Seven Springs Fire Station 
Santa Clara Valley Medical Center 

February 2006 45



Outpost Packet Message Manager v2.0.4 
Users Guide 

Fields Description 
Tactical ID A 3 character text field that can contain an abbreviation of 

the tactical location.  Sample tactical IDs (and what they 
could refer to) are:  
SSF (Seven Springs Fire Station) 
VMC  (Santa Clara Valley Medical Center) 
 
Tactical IDs are used in 2 areas:  On-line reports, and as 
Automatic Message Identifiers.  When turned on, the 
Automatic Message Identifiers feature creates a 
concatenated field of the �Tactical ID� and the �Next 
Message Number� that is inserted in the message�s Subject 
Line.  For instance, if the next message number is 247 and 
the Tactical ID is �VMC�, the prefix �VMC247: � would 
be inserted on the subject line. 

Text Variable 
#1, #2, #3 

Three free-form text fields that can contain any string. 
 

 

Re port variables can be accessed by the following Outpost features.  Note that all 
settings can be used with On-Line Reports. 

Field On-Line 
Reports 

NTS Message 
Maker 

Message 
Subject Line 

Next Message Number ! ! ! 
Organization !   
City ! !  
County !   
State/Prov ! !  
Tactical Location !   
Tactical ID !  ! 
Text Variable #1, #2, #3 !   

 

To fill in the report variables, do the following: 

1. From the Outpost main menu, select Tools > Report Settings. 

2. Fill in the fields.  When done, press OK.  

Typically, defining report values only has to be done once for all reports.  Once 
these fields are filled in, the report values will be referenced by any of the above-
mentioned functions during run-time.   

See the section on On-Line Reports, for information on how references to these 
values can be embedded into your custom reports. 
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7 Working with Messages 
7.1 Introduction 

Sooner or later, you will want to create and send a message.  This is where 
Outpost�s Message forms come in.  There are two ways to get to these forms: 

 
1. From the Main Outpost window, you can create a new message by either 

pressing the New button, or the Actions > New Message menu.  Or,  
  

2. You can view an existing message by highlighting the message with the mouse 
and either pressing the Open button, select the Actions > Open a Message 
menu, double-clicking on the message, or just press the �Enter� key.   

 
NOTE: With the In Tray selected, new unread messages are listed in BOLD.   

Urgent Messages are listed in RED!! 
 

Figure 29: Message Windows for editing and viewing 
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7.2 The Message Window Layout 
There are 2 message windows, one for viewing, and one that allows you to create or 
edit a message. 

▪ Messages that were just created or waiting to be sent can be opened for 
editing. 

▪ Messages that have been sent or were received can only be opened for 
viewing. 

Regardless of your choice (view or edit), the 2 message window formats are 
essentially the same and present a typical message context.  The windows are 
divided into three primary areas:   

 

Title, Menu, 
Toolbar

Address Fields

Message area

Title, Menu, Title, Menu, 
Toolbar

Address Fields

Message area

Title, Menu, 

Figure 30: Message Window Layout 

7.3 Menus and Toolbars 
The Program Controls portion of the Message Window controls how the message 
will be created, stored, or structured.  Unless otherwise noted, all menus and 
controls are identical on both the Edit and View-only Forms. 

NOTE:  Some of the more common menu items are also implemented as Tool Bar 
 buttons.  See the associated menu item below for their description. 

 
Menu Description 
File Send:  Edit-only Form.  Outpost checks that all fields 

are filled in, saves the message to the Out Tray, and 
then closes the Message Form.   
If the message is greater than 10,000 characters, a 
warning is issued.  If the user presses OK, then the 
message is truncated to 10,000 characters. 
Also a button on the toolbar. 
 
Open a File.  Prompts the user to select a text file 
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Menu Description 
from the system file area.  Once selected, the file�s 
content is loaded into the message area.  No address 
information is written to any address fields. 
Open a Report.  Prompts the user to select a Report 
form file from the system file area.  Once selected, 
three things happen:  
(i) the file�s contents are loaded into the message area, 
(ii) any embedded <tags> are replaced, and  
(iii) cursor positions to the first data input point. 
See Section 12 Online Reports for more details. 
Save.  Edit-only Form.  Checks that at least the 
Subject field is filled in, saves this message to the 
DRAFT Folder, and then closes the Message.   
If the message is greater than 10,000 characters, a 
warning is issued.  If the user presses OK, the message 
is truncated to 10,000 characters. 
Also a button on the toolbar. 
Save As.  Allows the user to save the message to an 
ASCII text file on the system disk.  Address 
information is also saved, but not in a format that can 
be reloaded back into the message heading fields. 
Save As, No Headers:  Saves the body of the 
highlighted message to an ASCII text file without the 
message headers (From, To, Date, Subject).    See the 
General Settings menu for information on enabling 
this feature. 
 
NTS Message Maker.  Edit-only Form.  Brings up a 
separate form that guides the user through the process 
of creating and addressing an NTS-compatible packet 
message.   
 
Process a Report.  Edit-only Form.  Manually 
causes Outpost to search a loaded On-line report for 
input prompts.  This option is enabled only after an 
Open a Report command (above) is performed. 
Clear Remaining Prompts.  Edit-only Form.  
Causes Outpost to remove all remaining On-Line 
Report prompts.  This option is enabled only after an 
Open a Report command (above) is performed. 
 
Print.  Allows the user to select a printer, and then 
print the currently highlighted message to the printer. 
Print Setup.  Allows the user to select a default 
printer for Outpost.  
 
Close.  Closes the form without saving or sending any 
message started. 
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Menu Description 
Edit Delete:  Deletes this message.  Also, same as the 

button on the toolbar. 
 
Cut:  Edit-only Form.  Copies and deletes any 
highlighted text from any field.  The text is placed in 
the MS-Windows clipboard. 
 
Copy: Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 
Paste:  Edit-only Form.  Inserts text from the 
clipboard at the position where the cursor is located. 
 

Actions Reply:  View-only Form.  For an existing message, 
opens a new message window, initializes the address 
fields, and formats the message as a Reply Message.  
Forward: View-only Form.  For an existing message, 
opens a new message window, initializes the address 
fields, and formats the message as a Forwarded 
Message. 
 
Private Message.  Edit-only Form.  Sets this 
message as a Private Message.  It will be sent with the 
SP command.  Also a button on the toolbar. 
NTS Message.  Edit-only Form.  Sets this message as 
a NTS Message.  It will be sent with the ST command.  
Also a button on the toolbar. 
Bulletin Message.  Edit-only Form.  Sets this 
message as a Bulletin Message.  It will be sent with the 
SB command.  Also a button on the toolbar. 
 
Request Delivery Receipt.  Edit-only Form.  
Requests that the receiving Outpost station 
automatically sends back a message indicating that the 
message was downloaded and received.   
Request Read Receipt.  Edit-only Form.  Requests 
that the receiving Outpost station automatically sends 
back a message indicating that the message was 
downloaded and opened.   
 

Help No On-line help enabled.  Points the user to this User 
Guide. 
 

URG Tool Bar only, Sets this message as an Urgent 
Message. 
See the figure 33 for an example of how an Urgent 
Received message is displayed. 
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7.4 Address information 
For a message to be considered valid and ready for sending, all 3 address fields and 
the Subject line must be to be filled in prior to sending a message. 

Field Description 
BBS When opening a new message, this field is set to the 

currently selected BBS.  However, it could be changed 
to a different BBS if desired. 
For received messages, this field contains the name of 
the originating BBS. 
 

From For new messages, this field is set to the currently 
configured Station Call Sign or Tactical Call (if 
enabled).   
When viewing a received message, this field contains 
the Station Call Sign or Tactical Call of the sending 
station. 

To For new messages, enter the FCC Call Sign or Tactical 
call of the station to which this message is to be 
delivered. 
The To Field can also hold a full hierarchical address 
for forwarding beyond the BBS.  This is in the form 
(i.e.): KN6PE@N0ARY.#NOCAL.USA.NOAM. 
When viewing an existing message, this field contains 
the Cal Sign or tactical call of the destination station. 
 

Subject For new messages, enter a subject for this message. 
When viewing an existing message, this field contains 
the subject of the message. 

7.5 Message Area 
The Message Area is a free-form text area that supports cut and paste, tabs (Cntl-
Tab), word-wrap, text importing, and other simple formatting functions.  Rich Text 
is not supported. 

Because of the ultimate transmission speed, Packet messages should be long enough 
to convey the intended meaning while being short enough to conserve bandwidth 
and minimize channel congestion. 

NOTE: Most HF BBSs have a 3000-character limit on packet messages.  If you must send 
large messages, it is recommended that you break them up into smaller messages to 
reduce channel contention.   

NOTE: Outpost enforces a hard 10,000-character limit for sent and received messages.  If 
the out-going message is greater than 10,000 characters, a warning is issued and the 
message is truncated.  For incoming messages, Outpost will truncate the message up 
to 10,000 characters, and then write the entire message to the Session Log file. 
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7.6 Creating a message 
The Steps for creating a message are: 

1. From the main Outpost Window, click on the New button.  A new message 
window will open.  The �BBS� and �From� fields are pre-loaded with the 
current system information.  These can be changed if necessary. 

2. Enter the To: (Destination) call sign.  Press Tab or use the mouse to move to 
the next field. 

3. Enter the Subject.  Press Tab or use the mouse to move to the Message Area. 

4. Enter the message.  Outpost will wrap any text that reaches the right side of the 
form.  If you are sending it to another Outpost station, word-wrap is handled 
correctly and all formatting is preserved. 
 

NOTE: For non-Outpost users, the message may not look as �neat� at the receiving end 
due to limitations of the receiving program and its ability (or inability) to 
handle line wraparounds. 

5. Verify the message type.  From the Actions Menu, set the message type 
(Private, NTS, or Bulletin) if you want something different from the default 
message type.  The message type is displayed in the highlighted area below the 
Tool Bar buttons.  

Figure 31: Selecting the Message Type 

6. The message Type can also be set using the three buttons on the message form:  

▪ Pvt:  Private 

▪ Bul: Bulletin 

▪ NTS: NTS message 

7. When you are done with your message and satisfied that it is the way you want 
it to look and read, press the Send button.  The message is placed in the Out 
Tray and will be transmitted during the next TNC Session. 

8. If you are not done, you can press the Save button.  The message is placed in 
the Draft folder.  You can retrieve, edit, and send it at a later time. 
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7.7 Creating Urgent Messages 
Outpost allows you to set up a message so that it is indicated as an URGENT 
message at the receiving end.  To do this, proceed as follows: 

 

Figure 32: Setting Message to Urgent 

A

B

A

B

1. On the Message form, press the �Urg� button (A).  The message is then 
indicated to be Urgent (B).  Pressing the �Urg� button again changes the 
message back to non-urgent. 

2. Once the message is sent and downloaded by the receiving station, it is listed in 
the In Tray with all the other messages, and indicated by:  
(i) 2 red �!!� in the �U� column, and  
(ii) a highlighted message listing in RED as an Urgent Message (C). 

 

Figure 33: Receiving an Urgent Message 

CC

3. The message will continue to remain listed in red until it is deleted from 
Outpost, forwarded, or replied to.  The message will also change from BOLD 
text to unbolded text to indicate it has been opened and read. 

February 2006 53



Outpost Packet Message Manager v2.0.4 
Users Guide 

7.8 Requesting Message Receipts 
Outpost also allows you to request a Delivery Receipt and/or a Read Receipt from 
the receiving Outpost station. 

▪ A Delivery Receipt is a request for notification that the Sent Message was 
actually downloaded.  It does not mean that it was successfully stored at the 
BBS. 
 
Once the receiving station retrieves their packet messages, the receiving 
station�s Outpost detects that a delivery receipt was requested.  During the same 
Packet Session that the message was downloaded, Outpost automatically 
formats and sends back a short Delivery Receipt message to the requesting 
station.  No user interaction is required. 

▪ A Read Receipt is a request for notification that the Sent Message was actually 
opened.  It does not guarantee that the message was actually read or 
understood.   
 
When a received message containing a Read Receipt is opened, Outpost detects 
that a read receipt was requested and automatically formats a short Read 
Receipt message.  This message will be sent back to the requester during the 
next send/receive session. 

▪ Both Delivery and Read receipts can be requested at the same time if desired. 

▪ To request a delivery or read receipt, from the message form, press  
Actions > Request Delivery Receipt.   
Repeat this for Actions > Request Read Receipt as required.  

 

Figure 34: Setting up a message with Receipt Requests 

 

AA
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After the message is delivered to the receiving station, the requesting station sees 
the following: 

▪ Entry in the message listing indicating a Delivery Receipt (B) 

▪ A short Delivery Receipt message containing date and time details of the 
receipt. 

A similar message listing and message is returned for Read Receipts. 

 

BB

Figure 35: A Delivery Receipt Message 
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7.9 Forwarding or Replying to a message 
Messages that you receive from another packet station can be forwarded to a 
different user, or replied back to the originator.  Outpost helps with the formatting 
so that the original message can be referenced. 

1. Forward.  After you select a message for viewing from the Outpost main 
window, you can press Forward.  This action does the following: 
� A new copy of the message is created and reformatted with an �original 

message� header.  The original message is preserved. 
� The From: field is set to the current Station Call Sign. 
� The To: Field is cleared and should be set to the station to receive this 

message. 
� The user can now add or edit the text message as appropriate. 
� Press Send when done. 

 

Figure 36: Forwarding a message 
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2. Reply.  This command operates exactly the same as the Forward with the 
following exception: 

� The From: and To: fields of the original message are swapped so that 
the message will be sent back to the originator. 

7.10 Forward and Reply Considerations 
1. The Forwarding and Replying feature does add text to the message that  

(i) may not always be needed, and (ii) consumes channel bandwidth.  This 
should be of particular concern if the packet channel is heavily used. 
 
If you need to reply to a message, consider editing the original message of 
unnecessary text to reduce the message bulk, provided you do not alter the 
meaning you want to communicate.  Your organizational policies on 
handling Forwards and Replies should be considered. 

2. When replying or forwarding a message, the message type is set according 
to the Message Settings found at Tools > Message Settings.  
Regardless of the setting, you can override this setting from Actions Menu 
by setting the message type as described above (Private, NTS, or Bulletin). 

7.11 Sending a text file 
The text of the message can also originate from a text file created elsewhere.  To 
import a message from a text file, do the following: 

1. From the main Outpost Window, click on the New button.  Fill on the To: 
and Subject: fields. 

2. Select File > Open.  Navigate to the directory where the file resides and 
select the file.  Press OK.   

3. The text will be loaded into the Message area and the message title is set to 
the text file name. 

Figure 37: Sending a text file 
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8 Customizing Message Settings 
 

8.1 Introduction 
While Outpost works fine �out of the box,� it does provide several options for 
controlling how the program behaves.  This section addresses Message Settings.   

There are several options that you can set to control how messages are handled.  
These settings are accessed from the main Outpost menu  
Tools > Message Settings.   

The form is made up of a series of Tabs across the top.  These tabs are: 

 
Tabs Description 
New Messages This tab covers how new messages are set up.  See the 

field descriptions below. 
 

Replies/Forwards Chooses how replies and forwards are handled.   
 

Tracking Allows the user to set global Delivery and Read 
Receipt requests. 
 

Deleting Controls for what happens when you delete a message. 
 

 

The following sections describe these tabs in detail. 
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8.2 Settings for New Messages 
This is the first tab on the Message Settings menu and controls how messages are 
created. 

 

Figure 38: New Messages Tab 

This set of options control how Outpost handles new messages.   

 
Control Group Description 
Message Type 
Default:   

Set Default to Private: When set, a new message 
defaults as a Private message.  Usually, most messages 
are sent as Private Messages to ensure that only the 
recipient sees the message.   
Set Default to Bulletin:  When set, a new message 
defaults as a Bulletin. 
NOTE:  If an NTS message is created, the default is 
 overridden and the message is set as an NTS  
 message. 
Default: Set Default as Private 
 

Default Destination For stations operating in the field or at a local 
municipality, it may be typical for them to address the 
bulk of their message traffic to the same Operational 
Area EOC or some other single station.  
To reduce the risk of addressing errors, this option 
allows the user to define a default destination address.   
To use this feature, check the Default Destination box, 
and then enter the destination address in field provided.  
The next time a new message is created, the To: field 
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Control Group Description 
on the message form is automatically filled in with this 
address.  If necessary, this field can be subsequently 
changed for �one-off� messages going elsewhere. 
Default: Not Set 
 

Add Message 
Number to Subject 
Line 

See the description below. 

 

 Adding Message Number to the Subject Line 
It is good operating practice (if not possibly a requirement of your organization) that 
all messages be uniquely identified so that they can be subsequently referenced.  
This option automatically places a Message identifier in the subject line of a 
message.   

To automatically add a message number to the subject line, do the following: 

1. Select  Tools  > Report Settings.  

2. Verify the �Next Message Number” field is set to the first number with 
which you want to start your message numbering. 

3. Verify the �Tactical ID” field is set to any special 3-character string 
identifier you may be using.  This field is Optional. 

4. Press OK when done.   

5. Select  Tools  > Message Settings.  

6. Click on �Add Message to Subject Line”. 

7. Press OK when done.   

For instance, suppose this option is enabled and the Report Settings form is filled 
in as follows: 

 
 

In Santa Clara County, �CUP� is the 3-character county designation for the City of 
Cupertino.  The next time a new message is created, Outpost automatically places a 
message identifier in the subject line in the following format: 

<tactical id><next message number>:

So, assuming the above report settings, the following is the result the next time a 
message is created: 
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At this point, the user can enter additional subject line text following the identifier.  
In Santa Clara County, the combination of the Tactical ID and the Message Number 
uniquely identifies this message for the County EOC. 

The next message created after the above message would have the Message ID of 
�CUP127: �, and so on. 

NOTE:  If the Tactical ID is left blank on the Report Settings form, then only the number is 
entered in the subject line. 
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8.3 Settings for Replies and Forwards 
This tab controls how a message behaves when it is selected for Replying or 
Forwarding.   

 

Figure 39: Replies/Forwards Tab 

 

The following table summarizes the options available. 
Control Group Description 
Replies/Forwards 
defaults 

Set default to Private Message:  When this item is 
checked and when replying to or forwarding a message, 
regardless of the original message type, the message 
will be set as a Private message. 
 
Set default to Received Message Type:  If this 
item is checked and when replying to or forwarding a 
message, the message type will be set to be the same as 
the original message type. 
NOTE:  This option excludes NTS messages. 
 
Default: Set Default to Private  
 

Close original 
message…  

To avoid desktop clutter, checking this box will close 
the original message after selecting it for replying or 
forwarding.  If you want to leave the original message 
open, uncheck this box. 
Default: Checked: close message on reply or forward. 
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8.4 Tracking Messages 
This tab controls how Outpost will behave for setting up global message receipt 
requests.   

 

Figure 40: Tracking Tab 

The following summarizes the options available. 
Control Group Description 
Always request a 
Delivery Receipt. 

This option is set by the originating station. 
When this setting is checked, all messages will be sent 
with a delivery receipt request set.  This option can be 
overridden for individual messages at the time the 
message is being created. 
 

Always request a 
Read Receipt.   

This option is set by the originating station. 
When this setting is checked, all messages will be sent 
with a read receipt request set.  This option can be 
overridden for individual messages at the time the 
message is being created. 
 

Auto-Reply Whereas the above 2 options are set by the originating 
station, this option is set by the receiving station. 
Sometimes, it is useful for the receiving station to send 
an acknowledgement that the message was read.  This 
is particularly useful for the EOC or some other central 
message location. 
This option sends a Read Receipt back to the 
originating station, REGARDLESS of whether a Read 
Receipt was requested by the originating station. 
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8.5 Settings for Deleting Messages 
This tab controls how outpost behaves when deleting messages.   

 

Figure 41: Deleting Tab 

The following summarizes the options available. 
Control Group Description 
Deleting 
Messages 

In general, deleting a message from any folder (other 
than the �Deleted Mgs� folder) will cause the selected 
message to be moved to �Deleted Mgs� folder. 
However, deleting a message from the �Deleted Mgs� 
Folder will permanently delete the message from the 
system.  This option determines whether the user is 
prompted to confirm that they want to permanently 
delete the message. 
Default: Prompt for final delete 
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9 Packet Session Manager 
9.1 Introduction 

The Packet Session Manager is the Outpost process that manages the entire 
interaction with the BBS through the selected interface (TNC, AGWPE, or Telnet).   
It initiates all commands needed to configure the interface and connect to the BBS, 
detects all TNC and BBS prompts, and controls the sequence of events to send and 
receive messages. 

After pressing Send/Receive from the Outpost main window, or if Send/Receive 
Automation is enabled, the following window opens and reports on the progress of 
the session. 

Figure 42: Serial Port Packet Session Manager Screen 

9.2 Toolbars 
Because the Packet Session Manager is an automated process, there is only one 
control on this form.  An additional option switch is also provided. 

 
Control Description 
Abort Session Attempts to terminate the Packets Session. 

Depending on where you are during the Packet session, 
the control will perform differently.   
Prior to completing a BBS connection, the session is 
terminated. 
After a BBS connection is established, Outpost 
attempts to force a disconnect from the BBS. 
 

Always show this 
window… 

Unchecking this box immediately minimizes this 
window, and causes it to be minimized for subsequent 
Packet Sessions.   
However, the Packet Session window will be available 
on the Windows Task Bar. 
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9.3 Status Line 
On the bottom of the form, status messages are displayed describing where we are 
during the session. 

 
Item Description 
Status Displays the current activity that the Packet Session 

Manager is performing. 
 

Session Timer Displays the time the Session has been in progress in 
minutes and seconds.  This timer is reset to zero at the 
beginning of each session. 

9.4 How the Packet Session Manager works 
The Packet Session Manager process relies on the correct configuration of the 
Interface and BBS.  During the configuration of these two items, various TNC (for 
Serial Port interfacing) or BBS prompts are loaded as defaults, added, or changed 
by the user.  The accuracy of setting these commands and prompts is critical to the 
correct operation on the Packet Session Manager. 

The following information describes the general flow of the Packet Session 
Manager.  Other than the interface initialization, the process is essentially the same.  
Interface specifics are described in this table below. 

 
Operation Description 
1. Start-up The Packet Session Manager is scheduled either 

manually from the Outpost Main form by pressing the 
Send/Receive button, or automatically.   
 
Prior to doing anything, a check is made to ensure: 
(i) Outpost has an FCC Call Sign set as the Station ID, 
(ii) an interface is selected, and  
(iii) a BBS is selected.   
 
If any of these are missing, an error message is shown.  
This error will also disable any automatic Send/Receive 
settings that were previously defined. 
 
Automatic scheduling can be set up by selecting the 
time interval between TNC Session runs.  Once a TNC 
Session ends, it will wait for the time period to expire 
before running again.  This is enabled from the  
Tools > Send/Receive Settings menu (see the next 
chapter for details). 
 

2. Interface 
Initialization 

Depending on the interface type selected, the initiation 
sequence is different.  However, the end result of all 
processes is to get to the point where Outpost can log 
on to the BBS. 
See the following 3 sections for specifics on the 
different interface initiation sequence. 
 

3. BBS Log-on A connect request is sent to the currently selected BBS.  
Once sent, Outpost looks for the BBS prompt as 
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Operation Description 
defined during the BBS Setup. 
 
If the Tactical Call box was checked during the BBS 
Setup, Outpost looks for the Tactical Call prompt and 
responds with the Tactical Call previously entered in 
the Log-on window. 
 

4. Process Bulletin 
or NTS Deletes 

For bulletin messages, you can issue a Delete Bulletin 
for a bulletin you previously posted.  Additionally, for 
NTS messages, you can accept an NTS message by 
deleting it off of the BBS. 
 
This step of the Send/Receive Session issues deletes for 
messages on the BBS for either of the above 2 cases.   

5. Send Messages Outpost checks for valid messages in the Out Tray that 
are addressed to this BBS. 
 
A valid message is any message that has been checked 
by pressing the Send button in the Message Window.   
 
NOTE:  Pressing Send ensures all fields are complete.  
Opening a previously validated message in the Out 
Tray, then pressing Save will not perform the 
validation, and the message will not be sent. 
 
For each message, Outpost uses the appropriate BBS 
Send command to format the message for sending, and 
then sends the message. 
 
After the message is sent and a valid BBS Command is 
received, Outpost moves the just sent message from the 
Out Tray to the Sent Msgs Folder, changes the message 
status to �Sent,� and sets the message time to the time it 
was sent.  Outpost repeats this process until all valid 
messages are sent. 
 

6. Retrieve 
Messages 

Outpost retrieves messages based on the Retrieve 
Message option settings:   
 
1. Checks which messages should be retrieved.  Any 

combination of Private, Bulletin, NTS, and 
Selected messages can be selected.  Also, if no 
message type is selected, no messages are 
retrieved. 

2. Checks the �Keep Messages on BBS� option to 
determine if the downloaded messages should be 
deleted. 

3. Checks the �Print on Receiving� option to 
determine if new messages should be printed and 

4. Checks the �Play on Arrival� option to determine 
if a .wav file needs to be played. 

 
These settings can be made from the  
Tools > Send/Receive Settings menu. 

February 2006 69



Outpost Packet Message Manager v2.0.4 
Users Guide 

Operation Description 
 
Assuming there are messages to be retrieved, the 
retrieval process begins with Outpost sending the 
appropriate BBS List command to generate a listing of 
private messages, bulletins, or NTS messages.   
 
For each message found in the BBS message list, 
Outpost does the following: 
(i) issues a BBS Read <message number> command, 
(ii) receives the message from the BBS,  
(iii) sets the message�s Date/Time , then  
(iv) stores the message in the In Tray.  
 
The Date/Time is set to the date and time listed on the 
BBS message list.  The 5 date/time formats that 
Outpost supports are:  
▪ mmdd/hhmm  
▪ dd/mm/yy  hh:mm:ss 
▪ dd-mmm-yy  hh:mm 
▪ yymmdd 
▪ dd/mmm 
 
A note on Selected Retrievals:  Up to 10 filter masks 
can be defined on the Send/Receive Settings form.  
If �Retrieve Selected Messages� is checked, then for 
each filter mask defined, Outpost will generate the list 
of BBS messages that satisfy that filter, and then 
retrieve those messages. 
 
A note on Bulletins:  Because only the originator or 
SysOp can delete bulletin messages, an additional 
check is performed before retrieving a bulletin.  If a 
bulletin shows up on the BBS message list, Outpost 
first checks to see if it has previously downloaded that 
bulletin based on the BBS Msg Nunber and the BBS 
Name associated with each message Outpost retrieves.  
If a copy exists anywhere on Outpost (regardless of the 
folder), then the bulletin is not downloaded.  If it does 
not exist, then bulletin is downloaded. 
 
After storing a received message in the In Tray, and 
depending on the message type, Outpost does 1 of 2 
things: 
� For Private messages, Outpost will either keep or 

delete the received message from the BBS based 
on a Tools > Send/Receive Settings. 

� For NTS and Bulletin messages, Outpost will not 
attempt to delete the message at this point.  See 
Step 4 above for details. 

 
A note on undeleted Private messages:  If the user has 
enabled the setting to �Keep messages on the BBS� 
option, than a similar check is performed each time the 
TNC session is run to ensure duplicate messages are 
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Operation Description 
not downloaded.  Once this option box is unchecked, 
the message then will be deleted off the BBS next time 
Outpost runs. 
 

7. Send Receipt 
Messages 

Prior to ending a session, any pending Message 
Receipts are sent out.  This second �Send� cycle allows 
for incoming messages with Delivery Receipt requests 
to be immediately processed without waiting for 
another session. 
 

8. BBS Log off Outpost sends a command to exit the BBS.  The 
command is considered successful when a TNC prompt 
is detected for a serial connection, or other termination 
statuses are reached for AGWPE or Telnet. 
 

9. Interface Shut-
down 

Finally, the interface is shut down based on the 
interface type.  See the following 3 sections for details. 

 

9.5 Serial Port Packet Session Specifics 
Outpost�s Serial Port operations follow a typical method for setting up and 
communicating to a device on a comm port.   

 
Operation Description 
1. Start-up See the description above.  Once Startup is complete, 

the serial port process picks up from here. 
 

2.1 Initialize the 
Comm Port 

Comm Port initialization is performed at the beginning 
of each Packet Session where a Serial Port Interface is 
selected. 
 
The Comm Port is initialized based on the data entered 
into the Comm Port Settings menu, and then the port is 
opened.  If the port is already in use by another 
program, an error message is displayed, and the Session 
ends. 
 

2.2 TNC 
initialization 

The TNC is initialized each time the TNC session is 
run. 
 
The first command Outpost sends to the TNC is a �b.� 
While the command typically causes the TNC to reply 
with its Broadcast status, it also forces a TNC prompt 
to be displayed (if the TNC is working correctly). 
 
Outpost looks to see if the TNC sent back a TNC 
Prompt string as defined during TNC Setup.  On 
detecting the prompt, a �TNC ok� message is displayed 
in the status window at the bottom of the display.   
 
Outpost then sends the following commands to set up 
the TNC: 
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Operation Description 
� Echo.  Sets the TNC echo status according to the 

setting entered in the Comm Port Setting.  �Echo 
On� causes the TNC to echo all Outpost 
commands sent to the TNC back to the Packet 
Session Manager window.  �Echo Off� causes all 
Outpost commands not to be displayed. 

� Mycall/TNC Identifier (call sign).  Sets the TNC to 
the call sign that is currently the Outpost call sign. 

� Monitor.  Forces TNC channel monitoring to OFF.  
This prevents the TNC buffer from filling up with 
unwanted text between TNC sessions. 

� Date/Time.  Sets the TNC to the date and time of 
the host computer. 

 
Normal Packet 
Session processing 

See steps 3 through 7 above 
 
 

8. Close Comm 
Port  

The Comm Port is closed thereby allowing other 
programs to access the serial port without closing 
Outpost.  
 

 

9.6 AGWPE Packet Session Specifics 
Outpost�s AGWPE implementation follows the standard interface approach as 
specified by SV2AGW.  The AGWPE sequence of events is as follows: 

 
Operation Description 
1. Start-up See the description above.  Once Startup is complete, 

the AGWPE process picks up from here. 
 

2.1 Connect to 
TCP/IP Interface 

The first action for an AGWPE interface is to establish 
a TCP/IP connection to the AGWPE program. 
 
Outpost uses the previously identified Host Name (or 
IP Address) and Port number to establish the 
connection with the AGWPE Program.  Outpost 
attempts to establish the connection, and then tests to 
determine if the connection succeeded.   
 
If the connection failed, an error message is displayed, 
and the Session ends.  Connection failures will be 
caused by AGWPE not running or the Host name or 
Port information being incorrect. 
 

2.2 AGWPE Log 
on & Registration 

Once a connection is established, Outpost does 2 
things: 
1.  If a logon was identified as being required, Outpost 
sends the Logon and Password command sequence. 
2.  Outpost registers itself with the AGWPE program 
under the call sign of the currently defined Station ID. 
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Operation Description 
 
While AGWPE does not return an error on a 
logon/password failure, it does indicate if the 
registration failed.  Reasons for a failed registration 
attempt are: (i) either the logon/password is required 
but were missing, (ii) the logon/password was required 
but was incorrect, or (iii) Outpost is already registered 
with AGWPE under this station ID. 
 

Normal Packet 
Session processing 

See steps 3 through 7 above 
 
 

8. AGW 
Disconnect 

Outpost sends a BBS disconnect command, then a 
TCP/IP disconnect command, and then an AGWPE 
Unregister request.   
 
Short of an AGWPE failure, this sequence will process 
correctly. 

9.7 Telnet Packet Session Specifics 
Outpost�s Telnet implementation follows the standard Telnet protocol.  The 
sequence of events is as follows: 

 
Operation Description 
1. Start-up See the description above.  Once Startup is complete, 

the Telnet process picks up from here. 
 

2.1 Connect to 
TCP/IP Interface 

The first action is to connect to establish a TCP/IP 
connection to the Server on which the BBS resides. 
 
Like AGWPE, Outpost uses the previously identified 
Host Name (or IP Address) and Port number to 
establish the connection with the BBS Server.  Outpost 
attempts to establish the connection, and then tests to 
determine if the connection succeeded.   
 
If the connection failed, an error message is displayed, 
and the Session ends.  Connection failures will be 
caused by network problems or the Host name or Port 
information was incorrect. 
 

2.2 BBS Server 
Log on  

Immediately on connecting to the BBS server, the BBS 
will send back a logon prompt.   
 
Because Outpost�s initial concern is to check for the 
connection, it does not watch for this prompt.  Instead, 
on testing that a connection to the BBS is successful, 
Outpost sends a Carriage Return to the BBS to force a 
new logon prompt.  The result on the Packet Session 
window is an error from the BBS complaining that no 
Logon was issued, followed by a new Logon Prompt. 
 
At this point, Outpost detects the Logon Prompt, and 
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Operation Description 
sends the Logon name.  It watches for the Password 
prompt, and then sends the password.  It is now looking 
for the BBS prompt.  Once it sees this, Packet Session 
processing continues as usual. 
 
If there is an error with the logon sequence, Outpost 
thinks it is waiting for the BBS prompt when instead 
the Logon sequence is probably being presented again.  
Here is where the Network time out value comes in.  
Outpost waits the value of the timeout, and then exits 
with an error message. 
 

Normal Packet 
Session processing 

See steps 3 through 7 above 
 
 

8. Telnet 
Disconnect 

Outpost sends TCP/IP disconnect command, and exits.  
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10 Customizing the Packet Session 
 

Outpost provides several options to control how the Send/Receive session executes.  
The control options are accessed from the Outpost main menu,  
Tools > Send/Receive Settings� These settings are discussed here. 

10.1 Automating the TNC Session 
Messages can be sent to the BBS whenever the Send/Receive button is pressed on 
the main Outpost Window. 

However, if Outpost is used as part of an ARES/RACES network for moving packet 
traffic within an Operational Area, then having the means for automatically sending 
outgoing traffic and polling the BBS for incoming traffic on a periodic basis allows 
Outpost to operate unattended, thereby making more efficient use of the emergency 
Responder staff. 

The Automation Section controls how TNC Sessions will be executed. 

Figure 43: Send/Receive Automation Menu 

 
Operation Description 
No automation When this option is checked, no scheduled 

Send/Receive Sessions are run.  This means that to 
initiate a session, the user needs to: 
▪ Press the Send/Receive button on the Outpost main 

form, or  
▪ Have Outpost send the message immediately after 

a message is created (discussed below). 
 

Schedule every 
“X” minutes 

Interval Scheduling: when this option is checked, 
Outpost will initiate a Send/Receive session every �X� 
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Operation Description 
number of minutes.  The timing for this is determined 
by the operator, with valid settings ranging from 1 to 
999 minutes (about 16 hours and 40 minutes). 
 
To use this feature:  
▪ Check the �Schedule a send/receive every [   ] 

minutes.� box. 
▪ Enter the number of minutes between sessions. 
▪ Press OK. 
▪ The time remaining until the next Send/Receive 

Session will be displayed on the status bar, bottom 
right, just to the left of the System Time. 

▪ To disable this setting, check the  
�No Automation� button, then press OK.   

 
See the Automaton Considerations section below for 
more information about how to use Send/Receive 
Automation. 

Schedule at “X” 
minutes past the 
hour 

Slot Time Scheduling:  There are times when it is 
desirable to explicitly control when a TNC Session is to 
run.  This is handled by using a concept known as �slot 
times.�  Valid slot times are in the range of 0 to 59, and 
correspond to the minutes pass the current hour. 
 
To use this feature:  
▪ Check the  

�Schedule a send/receive at [  ] [  ] [  ] [  ] 
minutes past the hour.� box. 

▪ Enter up to 4 absolute times in minutes when you 
want Outpost to run.  The times are the minutes 
during an hour when a session will run.  For 
instance, entries of 2, 17, 32, and 47 mean 2 
minutes past the hour, 17 minutes past, etc. 

▪ Press OK. 
▪ Based on the current PC system time, Outpost will 

determine the next time to run a TNC Session, and 
the time remaining until that Session will be 
displayed on the status bar, bottom right, just to the 
left of the System Time. 

▪ To disable this setting, check the  
�No Automation� button, then press OK.   

 
See the Automaton Considerations section below for 
more information about how to use Send/Receive 
Automation. 
 

Send a Message 
immediately when 
it is complete. 

This setting causes Outpost to initiate a TNC Session 
immediately on completing a message and it is 
validated by pressing the �Send� button on the message 
form.  A full TNC Session will then run. 
 
This option does not have any impact on any other 
existing Automation timing that may already be 
selected.  The session timer will continue to count 
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Operation Description 
down to the time of the next TNC Session regardless if 
it is 15 minutes from now or 30 seconds from now. 

 Automation Considerations 
In general, automatic message retrieval allows Outpost to be physically located in 
the radio room and periodically check for incoming or out-going messages.  This 
meets the requirement for having a control operator present. 

The rules around applying automatic message retrieval timing will need to be 
worked out within the Operational Area.  For instance, in a configuration with a low 
traffic/low station count, setting an interval time may work with little or no 
collisions.  However, this may not be the case with a high traffic volume or a large 
number of stations needing access to a single BBS. 

For instance, consider an environment of 5 Hospitals needing access to a single 
BBS using a single channel.  If the objective is to avoid all transmission collisions 
and maximize the times to check for messages, then the 5 Hospitals could be 
coordinated and assigned time slots with 3 minute intervals.  For instance: 

Slot 1 Slot 2 Slot 3 Slot 4
Hospital 1 0 15 30 45
Hospital 2 3 18 33 48
Hospital 3 6 21 36 51
Hospital 4 9 24 39 54
Hospital 5 12 27 42 57

Slot times

 
 

Similarly, 8 hospitals could be assigned time slots with 2 minute intervals: 

Slot 1 Slot 2 Slot 3 Slot 4
Hospital 1 0 15 30 45
Hospital 2 2 17 32 47
Hospital 3 4 19 34 49
Hospital 4 6 21 36 51
Hospital 5 8 23 38 53
Hospital 6 10 25 40 55
Hospital 7 12 27 42 57
Hospital 8 14 29 44 59

Slot times

 
 

In the above case, Hospitals 8 and 1 are within 1 minute of each of their slots and 
some contention may result. 

▪ Most BBS�s are very robust and can handle multiple connections at the same 
time.  There is no requirement to avoid concurrent access to a channel by 
multiple Outpost users.  Channel contention is still handed by the TNC.   

▪ When configuring the Outpost environment with time slots, all Outpost 
deployment teams should take into account available transmission speeds (1200 
vs 9600 baud), expectations for packet traffic volume, number of packet 
stations on a channel, and the willingness of served agencies to accept delays 
due to time-outs when channel contention occurs.  Some experimenting may be 
required. 
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▪ Not all slot times need to be filled in.  At least 1 time slot must be configured 
for this feature to be used. 

▪ There could be situations where some packet stations may generate more 
packet traffic then others and need access at least 4 times an hour.  Other 
stations may need fewer slots.  Again, these assignments should be carefully 
planned and coordinated to fully optimize the channel. 

10.2 Selecting messages for retrieval 
The 2nd tab allows you to configure Outpost to selectively retrieve three types of 
messages from the BBS: 

Figure 44: Retrieving Menu 

 
Operation Description 
Retrieve Private 
Messages 

Private messages are addressed to an individual.  Once 
Outpost retrieves and stores a private message, the 
message is deleted off of the BBS (unless configured to 
do otherwise). 
 

Retrieve NTS 
Messages 

NTS messages are identified by an address that 
includes a zip code and state (95014@NTSCA).  Once 
Outpost retrieves and stores an NTS message, the 
message is deleted off of the BBS (unless configured to 
do otherwise). 
 

Retrieve Bulletins  Bulletin messages are addressed to anyone who can 
access the BBS.  Outpost will not attempt to delete 
retrieved bulletin messages off of the BBS. 
 
When Retrieve Bulletins is selected, Retrieve Messages 
based on Filters will be disabled. 
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Operation Description 
 

Retrieve Messages 
based on Filters 

Selected Messages are one or more messages that 
satisfy a filter or mask.  At least 1 filter must be 
entered. 
 
When set, during the next Packet Session, Outpost will 
perform a message list and retrieval cycle for each filter 
mask that is identified. 
 
When Retrieve Messages based on Filters is selected, 
Retrieve Bulletins will be disabled. 
 
See Filtered Retrieval Considerations below for more 
details on this feature. 
 

Skip Bulletins I 
sent 

Bulletins that you originate will normally be retrieved.   
 
If this option is checked, the bulletins you send will not 
be retrieved, thereby reducing channel contention by 
not downloading a bulletin that is now currently in your 
Sent Folder. 

 Filtered Retrieval Considerations 
When Emergency Response Organizations rely on a networked BBS for their 
message traffic where operational and non-operational traffic may be present, or 
when a BBS is used to post a variety of bulletin data, retrieving ALL bulletins is 
neither an effective option nor an efficient use of the frequency. 

Most BBSs offer one or more commands that allow the user to retrieve messages 
based on the destination (To:) Call Sign or the message�s category (category @ 
route).  Outpost supports the capability to selectively retrieve messages during a 
TNC Session based on the message list-matching capabilities of the BBS. 

A cursory check of a few BBSs shows that there are different commands for filtered 
message listing.  Some of these commands are: 

 

L> string List the messages where �string� matches the call sign of the 
destination address; could match the category field in a 
destination address (category @ route).   
BBS: AA4RE, F6FBB, some TNC PBBSs. 

L string List the messages where �string� matches the category field 
in the destination address (category @ route).   
BBS: MSYS 

 

NOTE:  Check your BBS for the exact command options for selective retrievals. 

The Filtered Retrieval Option is intended for selective retrieval of BULLETIN 
messages.  This means: 

1. The �Retrieve Private Message� option should still be used to retrieve 
private messages addressed to you. 

2. Selectively retrieved messages are bulletins; no attempt will be made to delete 
them off of the BBS. 
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3. BBS retrieval rules apply: if a selectively retrieved message was previously 
downloaded and is still on Outpost, no attempt is made to download it again. 

 Other Considerations 
▪ If a Bulletin is sent to a specific individual (such as KN6PE) instead of a 

general category (such as ALLCTY, etc.), that message will be picked up as a 
Private message regardless of the BBS message setting and is subject to the 
Private Message handling rules described above.  However, the receiving 
Outpost station will not be able to delete it because it was not the author.  Only 
the originators of Bulletins can delete the bulletin. 

▪ NTS messages will be deleted from the BBS if Outpost retrieves them.  If you 
have no intention of servicing an NTS message, DO NOT SELECT NTS 
MESSAGES FOR DOWNLOAD.  If you accidentally download an NTS 
message, please post it back to the BBS for proper handling. 

10.3 Once a message is received 
The 3rd tab handles settings once a message is downloaded by the receiving station. 

 

Figure 45: Receiving Menu 

 
Operation Description 
Play this sound on 
arrival 

This option allows you to select a .wav file to be played 
when a message is saved in Outpost. 
 
The user can browse for a .wav file, select it, and test it 
to confirm that it is suitable for their environment. 
 

Print Messages  Checking this box will cause Outpost to print each new 
message received on their arrival.  Newly arrived 
messages can be printed automatically to expedite 
routing incoming messages to the EOC or Operational 
Area staff.   
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Operation Description 
 

Keep on BBS, do 
not delete after 
retrieving 

There are cases where it may be desirable to leave 
Private or NTS messages on a BBS after they are 
downloaded.  For instance, a municipality or response 
team may be operating 2 Outpost stations in different 
locations under the same Operational Call sign (if the 
BBS supports it) and wants both stations to see 
messages specifically intended for them. 
 

 Play on Arrival Considerations 
This feature requires that an operational Sound Card is installed.  Once you choose 
a .wav file, pressing the �Test� button will cause the .wav file to be played.  If there 
is a problem with the file or the sound card, the system will issue a �beep� instead. 

Two .wav files were included with the v2.0 distribution as examples for how this 
feature could be used.   

▪ Sound38.wav � an obnoxious alarm.  If you use this file with the sound turned 
up, you will definitely know when a message arrives. 

▪ incoming.wav � a spoken notification.  The phrase �Attention, incoming packet 
message� is spoken. 

Essentially, you can use any .wav file found on your system, or you can create your 
own.  The "incoming.wav" file was created using the Microsoft "Sound Recorder" 
program that comes standard with Windows. 

 Print on Arrival Considerations 
This feature requires a printer to be configured.  If no printer is installed, this option 
will be disabled. 
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10.4 Show Session 

 

Figure 46: Other Menu 

The 4th tab has only one option. 
Operation Description 
Show TNC Session 
Window 

When the TNC Session runs, a window pops up and 
displays the transactions between Outpost and the 
TNC.  To hide this window, uncheck this option. 

 Considerations 
This feature can also be set or reset directly on the TNC Session Window. 
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11 NTS Message Maker 
 

NOTE:  NTS and NTS Packet are significant topics by themselves and are beyond the scope 
of this document.  For more information on NTS Packet, see the document titled: 
Introduction to the National Traffic System available on the Outpost website. 

11.1 Introduction 
Outpost supports NTS with the NTS Message Maker.  This feature formats an NTS 
message by presenting the user with a form that enforces the addressing and 
formatting rules required to comply with standard NTS-formatted packet messages. 

This section describes the NTS Message Maker form and how it works.   

 

Title, Menu,
Tool

NTS
Preamble

Destination Address

Message

Signature

Title, Menu,
Tool

NTS
Preamble

Destination Address

Message

Signature

Figure 47: NTS Message Maker Form 

11.2 Menus and Toolbars 
The following controls are provided as part of the drop-down menus.  

 
Menu Description 
File Close:  Closes the NTS Message Maker form without 

saving the message.  Pressing the button will cause any 
message entered to be lost. 
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Menu Description 
Edit Cut:  Copies and deletes any highlighted text in any 

field.  The text is placed in the MS-Windows clipboard. 
 
Copy: Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 
 
Paste:  Inserts text from the clipboard at the position 
where the cursor is located. 
 
Clear Message.  Clears only the Address, Message, 
and Signature fields.   
 
Clear All.  Clears all fields on the form.   

 

Additionally, the following toolbar controls are also provided.  

 
Controls Description 
ARL Msg Brings up a form that allows the user to select either a 

Routine or Emergency ARL message.  Once a message 
is selected, the user is prompted for any embedded data 
needed to complete the message. 
 

Check This button does the following: 
� Checks to make sure that all required fields are 

filled in.  If a required field is missing, the field is 
highlighted. 

� Reformats the Message Text to be consistent with 
NTS packet formatting rules.  This includes 
replacing each period �.� with an �X� as well as 
ensuring there are only 5 words per line. 

� The Preamble �Check� field is filled in. 
 

Save Performs a Check of the message (same as above), then 
saves the message to the Message Form.  The message 
form fields are filled in per the standard NTS packet 
message format. 
 

Clear Message Clears the Address, Message, and Signature fields.  
 

Cancel Closes the NTS Message Maker form without saving 
the message.  Pressing this button will cause any 
message entered to be discarded. 
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11.3 NTS Preamble 
The following fields are part of the NTS Preamble.  

Field Description 
Msg No. Required field.  This is a sequential number beginning 

with 1 each month or year to be assigned by the 
originating station. 
 
Outpost stores the last NTS preamble used.  No 
automatic Message Number incrementing is performed.  
The originating station should increment this number 
each time they create an NTS message. 
 

Precedence Required field.  The Precedence is a single character 
to be entered in this field.  The four categories of 
Precedence are: 
� EMERGECNY:  Any message having life or 

death urgency to any person or group of persons.  
This includes official messages to welfare agencies 
during emergencies requesting supplies, materials, 
or instructions vital to relief of stricken populace in 
emergency areas.  Use the abbreviation �E� in 
packet messages. 

� PRIORITY:  Important messages having a 
specific time limit.  Official messages not covered 
in the Emergency category are covered here.  Use 
the abbreviation �P� in packet messages. 

� WELFARE:  A message that is either (a) an 
inquiry as to the health and welfare of an 
individual in the disaster area or (b) an advisory or 
reply from the disaster area.  Use the abbreviation 
�W� in packet messages. 

� ROUTINE:  Most traffic normally will bear this 
designation.  During a disaster, Routine traffic 
should be handled last or not at all when circuits 
are busy with other traffic. Use the abbreviation 
�R� in packet messages. 

 
Handling Instr Optional field.  Handling instructions (HX) serve to 

convey any special instructions to handling and 
delivering operators.  The following definitions apply: 
� HXA number  - Collect landline (phone calls) 

delivery is authorized by the addressee within 
number miles (if no number, authorization is 
unlimited).  Enter only �A number� 

� HXB number  - Cancel message if not delivered 
within number hours of filing time; service the 
originating station.    Enter only �B number� 

� HXC  - Report date and time of delivery (TOD) to 
originating station.  Enter only �C� 

� HXD  - Report to originating station the identity of 
station from which received, plus date and time.  
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Field Description 
Report identity of station to which relayed, plus 
date and time, or if delivered report date, time, and 
method of delivery.  Enter only �D� 

� HXE  - Delivering station get reply from 
addressees, originate a message back.  Enter only 
�E� 

� HXF number  - Hold delivery until number (date).    
Enter only �F number� 

� HXG  - Delivery by mail or landline toll call is not 
required.  If toll or other expenses are involved, 
cancel message and service originating station.  
Enter only �G� 

 
Station of Origin Required field.  This is the first amateur station to 

handle the message.  Typically, this would be your call 
sign if you are transmitting the message. 
 

ARL Message Optional Field.  This is a check-box indicating this is 
an ARL message.  These messages include an ARL 
message number in the body of the text.  Check this 
box if an ARL message number is used. 
 

Check Optional Field.  This is the number of words in the text 
of the message.   
 
This field will automatically be updated whenever the 
Check or Save buttons are pushed.  If you enter a 
value in this field, it will be overwritten. 
 

Place of Origin Optional Field.  This is the general location where the 
message originated (not necessarily location of station 
origin) and is usually a city and state, or occasionally 
an event, such as 2003 Moffett Air Show, CA. 
 

Time of Origin Optional field.  Represented in Universal Coordinated 
Time (i.e.: 1230z). 
 

Date of Origin Required field.  Usually is mmm dd format (i.e.: Sep 
18) and must correspond with date of time that this 
message was first entered into the NTS system. 
 

11.4 Destination Address 
The following fields are part of the NTS Message Destination Address.  

Field Description 
Name Required field.  The name of the individual to whom 

this message is to be delivered. 
 

Call Sign Optional field.  If the recipient is an Amateur Radio 
Operator, enter his or her call sign here. 
 

Address Optional field.  Street address if available. 
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Field Description 
City Required field.  The city where the recipient lives. 

 
State/Prov Required Field.  The state or province where the 

recipient lives. 
 

ZIP/Postal Required Field.  The 5 U.S. digit zip code or the 6 or 7 
character Canadian Postal Code where the recipient 
lives. 
 

Phone Number Highly Desirable (but optional) Field.  If a phone 
number is known, enter the Area Code, Exchange, and 
number. 

 

11.5 Message Text and Signature 
The last two fields hold the body of the message and the signature.  

Field Description 
Message text Required Field.  If possible, the text should be limited 

to 25 words.   
 

Signature Required Field.  This is the signature (and call sign of 
the message was sent from another Amateur radio 
Operator) of the person sending the message.   
 
This is not necessarily the person who is sending the 
message by packet. 
 

 

11.6 Creating an NTS message 
Refer to the example in Figure 47: NTS Message Maker Form for how the form is 
initially filled in.  The steps for using the NTS Message Maker are: 

1. From the Outpost main menu, press New to open the Message form. 

2. From the Message form, select File > NTS Message Maker. 

3. Fill in the fields.  When done, press Check to validate the entries and 
complete the message formatting.  If any required fields are missing, that 
field will be highlighted.  

4. When done, press Save.  The Message form is filled in with a correctly 
formatted NTS message.   

5. From the Message form, press Send. 
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11.7 Finishing up an NTS message 
Once the message is composed and all fields are filled in, press the Check button 
and Outpost updates the Preamble�s �Check� and Message fields.  Also, the status 
line indicates the results of the check.  The following is what the above message 
would look like after Check is pressed. 

“Check” field is
calculated and 

Updated

Message is
Reformatted

Status

“Check” field is
calculated and 

Updated

Message is
Reformatted

Status

Figure 48: NTS Message Maker after performing a Check 

 

Next, press the Save button.  Outpost writes the contents of the NTS Message 
Maker back to the Message form.  Note the Message Type is set to NTS.  

Figure 49: NTS Message written to the Message Form 
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Finally, press the Send button.  The NTS message shows up in the Outpost Out 
Tray.  This message will be sent during the next TNC Session.  

 

Message type
updated to NTS

Message type
updated to NTS

Figure 50: An NTS Message in the Out Tray 

11.8 Selecting an ARL Message 
Outpost lets the user select and apply one or more ARL standard messages to an 
NTS message.  This works as follows: 

1. From the Outpost main menu, press New to open the Message form. 

2. From the Message form, select File > NTS Message Maker. 

3. Fill in the Preamble and Destination Address fields as described above. 

4. Press the ARL Msg button.  The ARL Dialog box opens.  The controls and 
fields associated with this dialog box are as follows: 

 
Controls Description 
Message Type Toggles between the list of Routine and Emergency 

ARL messages. 
 

Next, Previous Selects the next or previous ARL message based on the 
type selected. 
 

Apply Takes the ARL message and applies it to the NTS 
message. 
 

Cancel Cancels this operation. 
 

Field Description 
ARL Number The literal ARL number of the selected message. 
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Field Description 
Message Text The message text associated with the selected ARL 

number.   
 
Some ARL messages require additional information to 
be provided by the user to complete the message.  This 
information can be found between the �<� and �>� 
characters. 
 

 

Figure 51: An NTS Message in the Out Tray 

 
5. Select the Message Type (either Routine or Emergency).  Using the Next 

and Previous buttons, select the desired message.  Press Apply when done. 

6. If additional information is required to complete the message, the user will 
be prompted for the fields that are required.  In the above example, 2 
additional prompts are issued: one for �Location�, and one for �Flight 
No/Train No/etc�. 

7. After the field is filled in, the message is inserted into the NTS Form. 

Formatted 
ARL Message

Formatted 
ARL Message

Figure 52: A completed ARL Message 

8. Complete the balance of the NTS message as previously described. 
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12 Online Reports 
 

Several ARES/RACES organizations have developed standard reporting tools and 
formats for collecting and transmitting information over packet.  In some cases, 
automated tools have been used to generate the reports using pre-defined forms that 
could be interpreted for efficient processing.  Online Reports is how Outpost 
addresses this requirement. 

12.1 Introduction 
An Online Report begins as a report form template that is developed outside of 
Outpost and saved as standard ASCII file.  When loaded into an Outpost message, 
the form�s embedded �tags� are updated and the user is guided to enter information 
in specific locations on the report form. 

There are three things that need to occur for Outpost to generate an Online Report 
that is ready for sending: 

1. Set up the report values 

2. Create the report form (template) 

3. Process the report form in an outpost message window 

This section describes these steps. 

12.2 Setting up the Report Values 
Report values refer to information that is typically referenced by one or more 
reports.  By defining these values up front, then referencing them with embedded 
<tags> in the report form, the report can be quickly filled in and sent on its way. 

 

Figure 53: Report Settings Menu 

To fill in the report variables, do the following: 

1. From the Outpost main menu, select Tools > Report Settings. 
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2. Fill in the fields.  When done, press OK.  

Typically, defining report values only has to be done once for all reports.  Once 
these fields are filled in, the report values will be referenced by a Report Form 
during processing.  See the Tag Definitions below for a description of these fields. 

12.3 Creating the Report Form 
Report forms are essentially ASCII text files that are post-processed by Outpost to 
create the final report.  The report form consists of 3 kinds of text entries: 

▪ General text.  This is canned text that is context-setting information to be sent 
as the report. 

▪ Tags.  Tags are variables that are embedded into a Report Form and then 
substituted with either automatic values or the values defined and stored by the 
�Report Settings� form. 

▪ Prompts.  A prompt is the character that is used to indicate the location where a 
user needs to input text for the report.  Outpost uses the equal sign (=) as the 
prompt character. 

 Tag Definitions 
The following table lists the report form tags and their meaning.  Note the source 
from where the tag information originates.   

Table 1: Definition of Report Tags 

Tag name Description 
<D>, <date1> Date.  The current system date, the format being: 

mm/dd/yy (example: 5/21/04). 
Source: Automatic Value 

<date2> Date.  The current system date, the format being:  
dd-mmm-yyyy (example: 21-May-2004). 
Source: Automatic Value 

<T>, <time> Time.  The current system time, the format being: hh:mm 
(24 hour format). 
Source: Automatic Value 

<M>, <msg#> Message Number.  The next message number as maintained 
by the application. 
Source: Report Setting Form 

<C>, <call> Call.  The currently defined Station ID.  Go to the Outpost 
menu Setup > Change Station ID to change. 
Source: Automatic Value 

<name> User Name.  The name entered at the Station ID form. 
Source: Automatic Value 

<bbs> BBS.  The currently selected BBS name. 
Source: Automatic Value 

<subj>text Subject.  The text immediately following the <subj> tag is 
appended to the Subject Line.  This tag should be on its own 
line with no other tags.  It will not be included in the body 
of the report. 

<org> Organization.  The organization to which the sending 
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Tag name Description 
station is affiliated, such as Cupertino ARES, Lake County 
RACES, etc. 
Source: Report Setting Form 

<city> City.  The City name. 
Source: Report Setting Form 

<county> County.  The County name. 
Source: Report Setting Form 

<state> State.  The 2-character representation of the state.  
Source: Report Setting Form, �State/Prov� field  

<province> Province.  The 2-character representation of the Province. 
Source: Report Setting Form, �State/Prov� field  

<tacloc> Tactical Location.  A reference to a location that is 
supporting a response, such as Quinlan Shelter, Deerfield 
Fire Station, or First Aid #1. 
Source: Report Setting Form 

<tacid> Tactical ID.  A 3-character string that can be used as a 
prefix to the message number to further ensure the 
message�s uniqueness. 
Source: Report Setting Form 

<text1> User-defined field.  This is 1 of 3 user-defined fields. 
Source: Report Setting Form 

<text2> User-defined field.  This is 2 of 3 user-defined fields. 
Source: Report Setting Form 

<text3> User-defined field.  This is 3 of 3 user-defined fields. 
Source: Report Setting Form 

= Prompt.  Causes Outpost to position the cursor at this 
location for the user to enter text. 

/ comment Comment.  Any text following this is considered a comment 
that will not be included when loaded into Outpost.  The �/� 
character must be the 1st character on a line.  If the �/� 
character is any place else, it is considered part of the 
report. 

 Tag Considerations 
▪ There are a few report variables that have 2 methods for representing them.  

Either method is valid. 

▪ Tags can be entered as either upper or lower case. 

▪ The same tag can be entered more than once in a report form. 

▪ When using the user-defined tags, care must be taken to ensure all users 
interpret the fields the same way in particular if a Report Form with user-
defined tags are shared among several stations.  

▪ If any field on the Report Settings menu is left blank, and a tag referencing that 
field is used, the tag will be replaced with nothing. 
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 Creating the Report Form 
Report Forms can be created with any text editor PROVIDED it can produce an 
ASCII text file.  The two text editors that are standard with MS Windows are 
Notepad and Wordpad.  Additionally, any other word processor can be used 
provided it can produce an ASCII file. 

The following is a sample report form developed with Notepad.  Note the different 
tags used throughout the report, the comment lines ( / ), and the prompt locations  
( = ) where user input is required. 

 

Figure 54: Report Form in Notepad 

Once the report form is created, it should be stored in a common location with other 
report form files.   

NOTE:  Whatever location you select for storing report forms, you should enter that 
directory location in the Directory Settings menu. 

12.4 Processing the Report Form 
With the Report variables and Report Form defined, you are ready to process the 
report. 

To process a report form, do the following: 

1. From Outpost, select New to open a new message form. 
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2. From the Message Form menu, select File!Open Report.  A file 
selection menu will open to the report directory you defined in the 
Directory Settings menu. 

3. Select the Report Form to be processed, and then press OK. 

In the following example, Outpost was set up to �Add a Message Number to 
Subject Line� and use the Report Settings as defined in Figure 53: Report Settings 
Menu.  

 

Figure 55: Report Form in Message Window 

4. Once the form is loaded, all <tags> are substituted with their automatic 
(date, time) or Report Settings defined (Tactical ID, Message number, and 
City) values.  

5. Next, the cursor is positioned over the first prompt (=).  Type over the 
prompt (=) to answer that question, then press Cntl-TAB or  
Right-Mouse-Click to progress to the next prompt. 

6. Continue entering all requested information until all prompts are replaced.  
You will be prompted if you want to start from the top, or tell you that there 
were no prompts found. 

7. To re-start prompt processing if you stop, select  
File > Process a Report. 

8. To clear any remaining Prompts that are not to be filled in, select  
File > Clear Remaining Prompts. 

9. When done, fill in the balance of the Message header (To:, Subject:, etc) 
and press Send. 
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13 Interactive Packet Window 
 

13.1 Introduction 
There are times when you will need to directly interact with either the TNC or the 
BBS for system maintenance or troubleshooting.  Outpost includes an interactive 
packet (IP) capability where the user can directly interact with the TNC or BBS.  
This section describes this feature. 

There are 3 separate Interactive Packet programs that are called by Outpost to 
support the different interface methods:  serial port TNCs (Ipserial.exe), AGWPE 
(Ipagwpe.exe), and Telnet (Iptelnet.exe).  The menus and controls on all 3 programs 
are essentially all the same, with minor variations to deal with the key interface 
differences. 

 

Figure 56: AGWPE’s Interactive Packet Window 

13.2 Menus, Tool Bar 
The following describes the Interactive Packet Program menus: 

Menus Description 
File Print.  Currently disabled. 

 
Comm Setting.  SERIAL PORT ONLY.  Sets up the 
serial port where the TNC is located. 
AGWPE Settings:  AGWPE ONLY.  Setup screen 
for identifying the AGWPE server, port, and logon 
information. 
Pick Via Stations:  AGWPE ONLY.  Identifies the 
list of via stations needed to get to the BBS. 
Telnet Settings:  TELNET ONLY.  Setup screen for 
identifying the BBS server and port information. 
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Menus Description 
Exit:  Causes the program to exit. 
 

Edit Cut:  Copies and deletes any highlighted text from any 
field.  The text is placed in the MS-Windows clipboard. 
Copy: Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 
Paste:  Inserts text from the clipboard at the position 
where the cursor is located. 
 
Select All:  Takes a copy of the entire contents of the 
IPW window and copies it to the MS-Windows 
clipboard. 
 

Tools Font.  Allows the user to change the font, Font style, 
and Size of all text in the window. 
 
AGWPE Version.  AGWPE ONLY.  Returns the 
version of the currently running AGWPE program.  
This menu option is enabled once you are connected to 
AGWPE. 
Show AGWPE Packets.  AGWPE ONLY.  When 
turned on, displays all raw AGWPE packets that are 
sent to and returned from the AGWPE Program. 
 
Log to Text File.  Sets up the file that will be used to 
log all activities that occur once the Start Logging 
button is pressed. 
 

 

The following controls manage how the program executes: 
Controls Description 
Connect The connect button does different things depending on 

whether you are running the Serial Port, AGWPE, or 
Telnet version of Interactive Packet. 
Serial Port 
Pressing Connect opens the Comm Port and sends a 
Carriage Return to the TNC.  If the TNC is connected 
and turned on, you should see the TNC prompt.  The 
Comm port is also automatically opened when the user 
starts to type in the IPW text window. 
If the Comm Port is open to another Outpost process 
(Outpost�s Packet Session Manager) or program, an 
error will be displayed. 
Pressing Disconnect closes the Comm port. 
AGWPE 
Pressing Connect initiates the AGWPE sequence.   
1.  The user is prompted to enter his/her call sign.  The 
last call sign used is entered as the default entry.  Then, 
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Controls Description 
the program attempts to register this call sign with 
AGWPE. 
2.  If the registration is successful, the user is then 
prompted to enter the BBS to which he/she wants to be 
connected.  The last BBS name previously entered is 
listed as the default entry.  AGWPE attempts to connect 
to the BBS.  If the BBS is not reachable, AGWPE 
times out and reports an error. 
3.  If the AGWPE performs a connect, the user can then 
interact with the BBS as usual. 
Telnet 
Pressing Connect initiates the Telnet connect sequence. 
The program connects to the Telnet server, and the user 
is presented with the logon prompt. 
Once you log on, you can interact with the BBS as 
usual. 
 

Disconnect After the Connect sequence is initiated, the text on the 
Connect button changes to Disconnect. 
When this button is pressed, the Interactive Packet 
program will initiate a disconnect from the specific 
interface to which it is connected.  In all cases, the 
disconnect is final. 
Once pressed, the button changes back to read 
Connect. 
 

Start Logging The Start Logging button is enabled once a file is 
selected and available for logging (Menu: Tools > 
Log to Text File).   
On pressing the Start Logging button, all subsequent 
text displayed in the text window will be written to the 
file regardless of whether it was entered by the user or 
returned from the device 
 

Stop Logging After the Logging is started as described above, the 
Start Logging button changes to read Stop Logging. 
When Stop Logging pressed, all logging to the file is 
stopped, and the button changes back to read Start 
Logging.   
If Start Logging is pressed again, the data is appended 
to the same file previously opened. 
 

Create Message Allows the user to create an Outpost message from any 
highlighted portion of the text window.   
If no text is highlighted, an error occurs. 
If the Interactive packet program is not in the same 
directory as the Outpost.exe program, this button will 
be disabled. 
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